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Trademarks 
Xanté® and Ilumina® are trademarks or registered trademarks of Xanté Corporation.

Adobe® Illustrator®, Adobe® Photoshop®, InDesign®, PostScript®, Acrobat®, and Acrobat® 
Reader™ are trademarks or registered trademarks of  Adobe Systems Incorporated which 
may be registered in certain jurisdictions. Macintosh®, EtherTalk®, AppleTalk®, and Mac® are 
registered trademarks of Apple Computer. 

Epson® is a registered trademark of Seiko Epson Corporation.

IBM® is a registered trademark of IBM Corporation.

PCL® is a registered trademark of Hewlett-Packard Development Company, LP. Microsoft®, 
MS-DOS®, Wingdings®, Windows NT®,and Windows® are registered trademarks of Microsoft 
Corporation in the United States and other countries. Arial® and New Times Roman® are 
registered trademarks of Monotype Corporation. 

Netscape Navigator® is a registered trademark of Netscape comminications Corporation in the 
United States and other countries. Novell® and NetWare® are registered trademarks of Novell, 
Inc. 

Sun™ and Solaris™ are trademarks of Sun Microsystems, Inc. in the United States and other 
countries.

Ethernet® is a registered trademark of Xerox Corporation. 

All other brand and product names are trademarks, registered trademarks, or service marks of 
their respective holders.

Manual Notice 
Xanté Corporation reserves the right to make changes to this manual and to the equipment 
described herein without notice. Every effort has been made to ensure that this manual is 
free of inaccuracies and omissions. However, Xanté Corporation makes no warranty of any 
kind including, but not limited to, any implied warranties of merchantability and fi tness for a 
particular purpose with regard to this manual.

Xanté Corporation assumes no responsibility for, or liability for, errors contained in this 
manual or for incidental, special, or consequential damages arising out of the furnishing of 
this manual, or the use of this manual in operating the equipment, or in connection with the 
performance of the equipment when so operated.

Proprietary 
The digitally encoded software included with the Xanté Ilumina Digital Color Press is 
copyrighted © 2005 by Xanté Corporation. All Rights Reserved. Patent Pending. This 
software may not be reproduced, modifi ed, displayed, transferred, or copied in any form or 
manner or on any media, without the express written permission of Xanté Corporation. 
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Copyright   
This manual is Copyrighted © 2005 by Xanté Corporation. All Rights Reserved. Printed in the 
USA. This manual may not be copied in whole or in part, nor transferred to any other media 
or language without the express written permission of Xanté Corporation.

Power Conservation  

  This product complies with the requirements of the Council 
Directives 89/336/EEC (EMC), 73/23/EEC (LVD) and 1999/5/EC 
(R&TTE), as amended where applicable, on the approximation of the 
laws of the member states relating to Electromagnetic Compatibility, 
Low Voltage and Radio & Telecommunications Terminal Equipment.

Colophon        
This manual was written using Adobe InDesign, Adobe Acrobat, Adobe Photoshop, Adobe 
Illustrator, and Microsoft Word. The typefaces for the main body of the manual are Times 
New Roman, Arial, Wingdings 3, and Symbol. 

◊◊◊



4  Ilumina Network and Confi guration Guidebb

Table of Contents
Chapter 1 - Introduction .........................................................................9

Introduction ..............................................................................................................9
Manual Conventions ..........................................................................................9

Chapters .................................................................................................................10
Print Server Specifi cations ....................................................................10

Network Summary Printout: ..................................................................................11
Confi guration Methods ..........................................................................................12

Chapter 2—Confi guring the Print Server ...........................................14
Confi guration: Using AdminManager Quick Setup ...............................................14

Introduction ......................................................................................................14
Using Quick Setup ...........................................................................................14

Confi guration: Using a Web Browser ....................................................................15
Launching the Web Browser ............................................................................16
Using the Web Browser ...................................................................................18
Changing the Password ....................................................................................19

Confi guration:  Using AdminManager Standard Setup .........................................19
Installing AdminManager ................................................................................20
The AdminManager Interface ..........................................................................21

Pull-Down Menus ......................................................................................21
Chapter 3 - Utilities ................................................................................36

Utilities:  PrintSuperVision Management Utility ...................................................36
PrintSuperVision’s Main Functions .................................................................36
System Requirements .......................................................................................36

Windows ....................................................................................................36
Supported Browsers ...................................................................................37
Supported Printers and Digital Color Presses ............................................38

Installing PrintSuperVision ..............................................................................38
Running PrintSuperVision ...............................................................................39

To run PrintSuperVision Server: ................................................................39
To run PrintSuperVision Client ..................................................................39
Help ............................................................................................................39

Uninstalling PrintSuperVision .........................................................................39
The PrintSuperVision Uninstall Program ..................................................39
The Windows Add/Remove Program ........................................................40

Utilities:  LPR Utility .............................................................................................40



Ilumina Network and Confi guration Guide  5

System Requirements .......................................................................................40
Installing LPR Utility .......................................................................................40

Step 1: Install the Ilumina Driver ...............................................................40
Step 2: Install The Utility ...........................................................................41
Step 3: Add The Ilumina to the Utility .......................................................42

Uninstalling the Utility ....................................................................................42
Chapter 4 - Security Features ...............................................................44

Security Features:  Overview .................................................................................44
SSL/TLS ..........................................................................................................44

IPP Encryption ...........................................................................................44
Web Encryption..........................................................................................44
Summary of SSL/TLS Encryption Functions ............................................46

Unused Protocols .............................................................................................46
Security Features:  IPP Encryption ........................................................................46

Setting Up IPP Encryption ...............................................................................46
Process Summary .......................................................................................46
Step 1:  Create the Self-Signed Certifi cate ................................................46
Step 2: Enable IPP Printing at Client Stations ...........................................51

Printing Using IPP Encryption .........................................................................54
Security Features:  Web Encryption .......................................................................54

Setting Up Web Encryption .............................................................................54
Process Summary .......................................................................................54
Step 1: Apply for a CA Certifi cate .............................................................54
Step 2: Install the Certifi cate ......................................................................59

Printing Using Web Encryption .......................................................................63
Security Features:  Unused Protocols ....................................................................63

Disabling Unused Protocols .............................................................................63
Chapter 5 - Printing from Microsoft Windows ...................................65

Printing from Windows:  Overview .......................................................................65
Printing from Windows:  Using TCP/IP Protocol ..................................................66
Installation Overview .............................................................................................66

Installing TCP/IP Protocol ...............................................................................67
Installing TCP/IP Protocol Windows XP .........................................................67

Installing TCP/IP Protocol Windows 2000 ................................................67
Installing TCP/IP Protocol Windows NT 4.0 .............................................68
Installing TCP/IP Protocol Windows Me/98 ..............................................68

Confi guring the IP Address, Subnet Mask, and Gateway ................................68



6  Ilumina Network and Confi guration Guidebb

Using Web Browser ...................................................................................69
Using AdminManager ................................................................................69

Confi guring Windows to Print to the Network Ilumina ...................................70
Confi guring Windows for Printing Windows XP ......................................70
Confi guring Windows for Printing Windows 2000 ...................................71
Confi guring Windows for Printing Windows NT 4.0 ................................72
Confi guring Windows for Printing Windows Me/98 .................................72

Chapter 6 - Printing Using Macintosh .................................................73
Printing from Macintosh:  Overview .....................................................................73

Supported Versions ..........................................................................................73
Printing from Macintosh:  Self-Diagnostic Test Printout ......................................73
Printing from Macintosh:  Installing the Driver ....................................................74

MAC OS 9.1+ ..................................................................................................74
MAC OS 10.1 ..................................................................................................75
MAC OS 10.2x ................................................................................................75
MAC OS 10.3x ................................................................................................76

Printing from Macintosh:  Setting Up the Ilumina ................................................76
OS 9.1+ ............................................................................................................76
OS 10.1 and Above ..........................................................................................76

Chapter 7 - Troubleshooting .................................................................78
Troubleshooting:  Network Summary Printout ......................................................78

Network summary does not print .....................................................................78
EEPROM check registers an ERROR .............................................................78

Troubleshooting:  TCP/IP ......................................................................................78
Ilumina Cannot Find the Network Interface Card. ..........................................78
Cannot Print with LPR and FTP.......................................................................79
Incorrect User Name on the Banner Page. .......................................................79

Troubleshooting:  NetBEUI ...................................................................................79
The Network Interface Card is not identifi ed ..................................................79
Error writing to PRN1 ......................................................................................80

Troubleshooting:  TCP/IP ......................................................................................80
Blank pages or garbled text printed .................................................................80
Banner print is rotated by 90 degrees and printed at bottom of paper .............80
No printing or print queue stopped ..................................................................81

Appendix:  The Ilumina Menu .............................................................82
Menu Basics ...........................................................................................................82



Ilumina Network and Confi guration Guide  7

Top Level Functions ........................................................................................82
Special Menu ...................................................................................................82

Ilumina Menu Overview ........................................................................................82
Table Conventions Used ..................................................................................82
Functions Menu Tree:  Admin Setup, Calibration, Print Statistics ..................83
Boot Menu Tree ...............................................................................................87
Parallel Setup ...................................................................................................87
USB Setup ........................................................................................................88
Security Setup ..................................................................................................88
Storage Setup ...................................................................................................88
Power Setup .....................................................................................................90
Language Initialize Setup ................................................................................90

Ilumina Menu Making Changes in the Menu ........................................................90
Making Changes in the Function Menu ...........................................................90

Example: Enabling FTP .............................................................................91
Making Changes in the Boot Menu .................................................................92

Ilumina Menu Functions List .................................................................................92
Admin Setup ....................................................................................................92

Password ....................................................................................................92
Network Setup ...........................................................................................92
Print Setup ..................................................................................................94
PS Setup .....................................................................................................96
PCL Setup ..................................................................................................96
IBM PPR Setup ..........................................................................................98
Epson FX Setup .........................................................................................99
Color Setup ..............................................................................................101
Memory Setup ..........................................................................................101
Flash Memory Setup ................................................................................102
HDD Setup ...............................................................................................102
System Setup ............................................................................................102
Change Password .....................................................................................103
Settings .....................................................................................................103

Calibration Menu ...........................................................................................103
Print Statistics Menu ......................................................................................105

Ilumina Menu Boot Menu ....................................................................................105
Parallel Setup .................................................................................................105
USB Setup ......................................................................................................106



8  Ilumina Network and Confi guration Guidebb

Security Setup ................................................................................................107
Storage Setup .................................................................................................107
Power Setup ...................................................................................................108



Ilumina Network and Confi guration Guide  9

Chapter 1 - Introduction
Introduction

 The network addresses used in this manual are shown for example only. 
Network addresses used in your installation must be generated from your 
network administrator.

The XantéLAN Internal Print Server is a fast 100BASE-T/10BASE-T network 
interface.      

This network print server supports IEEE 802.2, IEEE 802.3, Ethernet-II, and SNAP, 
and can detect those frame types automatically. It supports major protocols such as 
TCP/IP, IPX/SPX (NetWare), EtherTalk (Mac), and NetBEUI (Windows).                

The print server has a number of security features, including SSL/TLS, IP Filtering, 
disabling unused protocols, etc. See chapter 4 for more information.    

Password protection ensures that the print server is safe from unauthorized changes 
in settings. You can also restrict access by disabling network services, protocols, and 
ports you are not using. You can limit access to specifi c authorized IP addresses as 
well.  

The STMP feature allows you to have an E-mail sent to designated addresses when 
certain errors occur.    

	 Change the emulation in the Ilumina Menu settings to Auto or PS before 
printing the self-diagnostic test and settings.   

Manual Conventions   
The following conventions are used in this manual:   

 � indicates that you need to press the Return key on a Macintosh or the 
Enter key on a PC.      

	 indicates additional or emphasized information to supplement the main 
text. 
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 indicates caution and instructions that must be followed to avoid damage 
to fi les or equipment. 

 indicates danger and warns that instructions must be followed exactly to 
avoid personal injury. 

: or → indicates the path for a fi le or folder and links procedure steps.  

< > indicates variable information such as the Ilumina’s name.  

Chapters
This book is divided into the following chapters: 

• Chapter 1—Introduction

• Chapter 2—Confi guring The Print Server

• Chapter 3—Utilities

• Chapter 4—Security Features

• Chapter 5—Printing from Microsoft Windows

• Chapter 6—Printing Using Macintosh

• Chapter 7—Troubleshooting

• Appendix—The Ilumina Menu

Print Server Specifi cations
Frame types • IEEE 802.2

• IEEE 802.3
• Ethernet-II, SNAP, AUTO

Network interface 1000BASE-T
• 100BASE-TX
• 10BASE-T
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Network protocols                                                                        • TCP/IP
– Network layer: ARP, RARP, IP, ICMP, PnP
– Session layer: TCP, UDP
– Application layer: PR, FTP, TELNET, HTTP, IPP, BOOTP, 
DHCP, SNMP, DNS, SMTP, POP3
• IPX/SPX (NetWare)
– Remote printer mode (up to eight fi le servers and 32 queues)
– Print server mode (up to eight print servers)
– Encrypted password supported in print server mode
  – SNMP
      • EtherTalk:ELAP, AARP, DDP, AEP, NBP, ZIP, RTMP, ATP, 
PAP
       • AppleTalk
• Bonjour
• NetBEUI: SMB, NetBIOS

Supported Operating Systems                    • Windows
– Vista
– XP
– 2000
• Macintosh
– OS X 10.2 or later

Print Service                 • LPR
• FTP
• Port 9100
• Web Direct Printing
• QSERVER Binder
• QSERVER NDS

Functions • Self-diagnostic test printing
• Banner supported
• Monitoring/confi gure by Web browser
• Ilumina status notifi cation by E-Mail

Network Summary Printout:

The printer server’s network summary reports the printer’s MAC Address (Ethernet 
address).

• Turn the printer on.

• Press the print server Test button for more than three seconds and release.

The printer’s MAC Address appears on the fi rst page under General Information.
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 General Information
 Network Function Name  Xante Ilumina

 MAC Address   00:80:87:1B:E9:14
 HUB Link Setting  Auto Negotiation
 HUB Link Status  OK (100BASE-TX Full)
 Network Status   Unicast Packets Received
     Packets Transmitted
     Unsendable Packets
     Bad Packets Received

The fi rst six digits of the MAC Address are the same for the XanteLAN print servers.

The last six digits fo the MAC Address are unique to each XanteLAN and are 
required to set up the print server.

The hub link status results are also printed (normally “OK”).

Confi guration Methods
You can confi gure the print server by using one of the following methods:

Utility  Features System Requirements
Quick Setup Confi gure the print server 

easily and simply without 
installing anyh software 
packages into your system.

You can set the following:
• Enable/disable TCP/IP,
• EtherTalk, NetBEUI
protocols
• Set IP address, Subnet 
Mask and Gateway for 
TCP/IP manually or by 
using DHCP.
• Zone name and Port 
name for EtherTalk.

Windows*
• Vista
• XP
• 2000

*with TCP/IP protocol or IPX/SPX 
protocol installed.
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Utility  Features System Requirements
AdminManager Confi gure the print server 

in detail.
Web Browser Confi gure the print 

server and printer by 
using a Web browser.

Microsoft Internet Explorer or 
similar.
Operating system that supports the 
Web browser

TELNET  Confi gure the print server 
using TELNET.

Third-party vendor developed 
TELNET client package.

A TELNET Application is standard 
in Windows.  

SNMP The printer and 
network card can be 
controlled using a 
third-party vendor 
developed SNMP 
application.

Third-party vendor developed 
SNMP application.

◊◊◊
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Chapter 2—Confi guring the Print Server
This chapter explains the various ways you can confi gure your print server. It consists 
of the following:

• Using AdminManager Quick Setup   

• Using a Web Browser 

• Using AdminManager Standard Setup

• Using TELNET

Confi guration: Using AdminManager Quick Setup 

Introduction

 • This utility can only be used on a PC that can be connected to the   
 network with TCP/IP or IPX/SPX.    

 • This utility must be used on a PC that is located in the same segment as  
 the Ilumina.

The AdminManager Quick Setup utility allows you to confi gure the print server 
easily and simply without installing any software packages.

You can confi gure the following:

• Enable/disable TCP/IP, EtherTalk, NetBEUI protocols.              

• Set IP address, Subnet Mask and Gateway for TCP/IP manually or by using 
DHCP.         

• Set NetWare mode and create Queue/Print Server/Printer objects.  

• Zone name and Port name for EtherTalk.     

Using Quick Setup  

1.  Insert the Drivers CD provided with your Ilumina into the CD-ROM drive and 
wait for it to autorun.
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 If the Menu Installer does not start automatically, click [Start] → [Run] → 
[Browse]. Browse to your CD-ROM and click [Install] → [Open] → [OK].

2. Click [Next] to accept the Software License Agreement, then select your 
language.

3. Click [Custom Install].

4. Click [Network Software].

5. Click [Installation/Confi g].

6. Click [Admin Mgr / Quick Setup]. The Setup Utility opens.

7. Select the language.

8. Click [Xanté Device Quick Setup]. The Welcome window will appear.

9. Click [Next] and follow the on-screen instructions.

	 The NetWare Client 32 or IntranetWare Client should be installed on the 
PC used for the creation of network queues. Installation enables the user to 
create network queues and perform other functions.  

10. When you are done making your selections, review them and if they are 
correct, click [Execute].

 The new settings are transmitted to the network card, but the network card is 
still operating with pre-transmission settings.

11. Click [Finish] to validate the new settings. The print server will reinitialize.

Confi guration: Using a Web Browser 
If the print server is connected to the network using TCP/IP, its settings and the 
Ilumina menu settings can be confi gured using a Web browser such as

 The network addresses used in this manual are shown as examples only. Network addresses 
used in your installation should be within the appropriate address range and have the correct subnet 
mask for your network segment..
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 To apply confi guration changes using a Web browser, you will be prompted  
 for a username and password 
 •  username = root
 •  default password = the last six digits of the MAC address.
 Note: The password is case sensitive, use uppercase.

Launching the Web Browser 

	 The illustrations below are from Microsoft Internet Explorer.

1. Have a copy of the network summary printout on hand

 • The MAC address is listed under “General Information.” You will use the 
last six digits of the MAC Address (minus punctuation marks) as the password 
when logging in for the fi rst time.

 • The IP Address, Subnet Mask and Default Gateway are listed under “TCP/IP 
Confi guration.”        

2. Launch the Web browser.

3. Enter the print server’s IP Address:

4. Press the ENTER key. The Ilumina Status window will appear.

	 You can also launch the web browser from within the AdminManager utility. 
To do this, highlight the appropriate print server, then click
[Setup] → [Setup by HTTP]:

5. To ensure correct operation, change the following browser setting:

a. Microsoft Internet Explorer: 
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1)  In the Tools pull-down menu, select [Internet Options].

2) On the [General] tab, under [Temporary Internet fi les], click 
[Settings…].

3) Under [Check for newer versions of stored programs], select 
[Every visit to the page].

4) Click [OK].

b. Netscape Navigator:

1) In the Edit pull-down menu, select [Settings].

2) Under [Details], click [Cache].

3) Under [Document in cache is compared to document on network], 
select [Once per session].

	 If you change the window size of the browser immediately after changing 
the confi guration, [Security information] may appear. Uncheck [Display this 
message next time].

6. Click [OK].

7. Click [Administrator Login]. The [Connect to] window will appear.

8. Enter “root” for the [User Name] and your password—the default is the last six 
digits of the MAC address—under [Password].
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9. Click [OK].

10. Click Skip to navigate to the main menu page.

Using the Web Browser 

1. Click on a tab to access the settings for a particular category.

2. In the left column, click the category for which you wish to make changes.

3. When you are done making changes, click [Submit] to send the to the print 
server.
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	 For more details on setting non-security type confi gurable items using the 
web browser, see “Confi guration: Confi gurable Items” later in this chapter.
For information on setting up security features using the web browser, 
see “Security Features: IPP Encryption” and “Security Features: Web 
Encryption”.

Changing the Password 

1. Open the browser and enter the IP Address for the print server, then login with 
your current password.

2. Click [Security] → [Password Confi guration].

3. Under [Administrator (root/admin) Password Confi guration], enter the new 
password, then enter it again under [Confi rm New Admin Password].

4. Click [Submit].

Confi guration:  Using AdminManager Standard Setup  
AdminManager Standard Setup is a powerful Microsoft Windows-based utility for 
confi guring all print server functions using a graphical user interface.

 • This utility can only be used on a PC that can be connected to the   
 network with TCP/IP or IPX/SPX.       
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 • This utility must be used on a PC that is located in the same segment as  
 the Ilumina.

Installing AdminManager 

1. Insert the Drivers CD provided with your Ilumina into the CD-ROM drive and 
wait for it to autorun.

 If the Menu Installer does not start automatically, click [Start] → [Run] → 
[Browse]. Browse to your CD-ROM and click [Install] → [Open] → [OK].

2. Click [Next] to accept the Software License Agreement, then select your 
language.

3. Click [Custom Install].

4. Click [Network Software]

5. Click [Installation/Confi g].

6. Click [Admin Mgr / Quick Setup]. The Setup Utility will open.

7. Select your language.

8. Click [Network Device Standard Setup]. When the Welcome window appears, 
choose one of the following two options.
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a. Run the utility from the CD [Execute from CD-ROM]

b. Load the utility onto your hard drive and run it from there [Install and 
Execute].

9. Click [Next].

a. If you selected [Install and Execute], follow the on-screen instructions 
to install AdminManager, then see the following section, “The 
AdminManager Interface.”

b. If you selected [Execute from CD-ROM], see the following section, “The 
AdminManager Interface.”

The AdminManager Interface 
To open the standard version of AdminManager from your desktop, click [Start] → 

[Programs] → [Network Device Setup Utility] → [AdminManager].

	 The CD will install to [Program Files\Admin 32]

Pull-Down Menus  

File menu

• Search:
Locates and lists all printers or digital color presses in your network which have 
the XantéLAN installed.

• Exit
Exit the program.

Status  Menu

• Printer Status 
Displays the current status of the Ilumina

• System Status
Displays the current  network card confi guration. The confi guration data can be 
saved as a log fi le.

• NetMeter 
Displays the current network status. For more information, see the NetMeter on-
line Help fi le.
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• List of Confi guration Items 
Displays current confi guration. Confi guration data can be saved as log fi le.

Setup Menu

• Network Device Setup 
Use this to confi gure the print server card.

	 To fi nd corresponding items in the Web Browser and TELNET, see the 
summary of confi gurable items in the “Introduction” at the beginning of this 
chapter.  

General Tab (Network Device Setup)     

The General tab allows you to change the admin password.

1. Click [Change].

2. Enter the current value, then enter the new value and re-enter it under 
[Confi rm …].

	 The default admin password is the last six digits of the MAC Address, 
minus any punctuation marks. E.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be A45579.

3. Click [OK].
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TCP/IP Tab (Network Device Setup) 

Item Comments
Use TCP/IP Protocol Enable/disable TCP/IP protocol. 
Use DHCP/BOOTP Click to select this item if the IP address, subnet mask, default 

gateway and IP addresses for DNS primary server and secondary 
servers are retrieved from the DHCP or BOOTP server.     

Use IPv6 Use to enable/disable IPv6.
Use Windows Rally Windows Vista only: Use to discover and confi gure devices over a 

network.
IP Address Set the IP address of the selected network interface card. 
Subnet Mask Set the subnet mask of the selected network interface card. 
Default Gateway Set the default gateway of the selected network interface card. 
Auto Discovery… Use to enable/disable Network PnP and Rendezvous, and to set the 

Device Name.  
DNS Server… Set IP addresses for DNS primary and secondary servers. 
WINS Server… Use to set IP addresses for primary and secondary servers, and to 

enter a Scope ID. 

Netware Tab (Network Device Setup)    

Item Comments
Use NetWare Protocol Enable/disable NetWare protocol.
User IPX Protocol Click to deselect if you do not wish to use IPX
User TCP/IP Protocol Click to select TCP/IP protocol.
Print Server Name Set a Print Server name.
Frame Type Set the primary NetWare frame type.
Operation Mode Select the NetWare mode:

PSERVER Mode (the default)
RPRINTER Mode

Bindery Setup check 
box.

Click to deselect Bindery. When Bindery Setup is deselected, the 
Bindery Setup... button is greyed out.
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Item Comments
Bindery Setup Confi gure Bindery mode items, including.

File Server to be connected. Specify up to 8 fi le servers to 
connect.

Password. Set a password for the Print 
Server

Job Polling Time Set the print job polling interval 
in seconds.

NDS Set the NDS Tree and Context where the Print Server was created.

RPRINTER Setup Appears if you select RPRINTER mode under Operation Mode.

The Following can be confi gured:
Print server to be connected. Specify up to 8 fi le servers to 

connect.
Time Out Set the duration from the last 

data’s arrival to freeing of the 
port, in seconds.

Printer Name Set the NetWare printer object name.

EtherTalk Tab (Network Device Setup)    

Item Comments
Use EtherTalk Protocol Enable/disable EtherTalk protocol.
Printer Name Set the EtherTalk Printer object name.
Zone Name Set the name of the zone to which the print server belongs.

NetBEUI Tab (Network Device Setup)    

Item Comments
Use NetBEUI Protocol Enable/disable NetBEUI protocol.
Short Printer Name Set a name for the print server.
Workgroup Set a name for the work group to which the print server belongs.
Comment Set the comments for the print server.
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SNMP Tab (Network Device Setup)

Item Comments
Use SNMP Enable/disable
SNMPv1
settings

SNMP Write
community

Change

SNMP Read
community

Change

SNMPv3
settings

User name Set a user name.
Authorization
settings

Options to Setup and 
Delete.

Privacy
(encryption)
settings

Options to Setup and 
Delete.

SysContact Set the printer manager name.
SysName Set the printer model name.
SysLocation Set the location where the Ilumina is installed.
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Item Comments
Printer Trap Setup…    The following items can be confi gured:

Printer Trap Community 
Name

This community name is assigned to 
outgoing printer status traps such as 
off-line, paper out, etc.

TCP #1 through TCP #5 Set up to fi ve IP addresses to which a 
Trap packet will be sent.

Detail… [for TCP #1 
through TCP #5]

Click to enable sending a Trap 
packet for any or all of the following 
selectable conditions:
•  Printer Reboot
•  Receive Illegal
•  Online
•  Offl ine
•  Paper Out
•  Paper Jam
•  Cover Open
•  Printer Error

IPX Set node address and network address 
to which a Trap packet will be sent.

Detail… [for IPX] Click to enable sending a Trap 
packet for any or all of the following 
selectable conditions:
•  Receive Illegal
•  Online
•  Offl ine
•  Paper Out
•  Paper Jam
•  Cover Open
•  Printer Error

E-mail (Send) Tab  

Item Comments
Use SMTP Transmit      Enable/disable sending E-mail using SMTP.
SMTP Server Name Set the host name of the SMTP server.
Printer E-mail Address         Set the E-mail address that is used in the [From] fi eld in the mail 

header.
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Item Comments
Destination Address 
1… through 5…

Set the following parameters:
Destination Address Set E-mail address to which E-mail should 

be sent.
Notify Mode Select PERIOD or EVENT.
When PERIOD is selected:
Check Time Used to set the interval at which the selected 

events are checked. E-mail will be sent 
at that interval for each selected event 
which has occurred.

Period Mode Set ON/OFF for the events 
listed.

When EVENT is selected
Event Mode Select Enable (ON), 

Disable (OFF) or 
Immediate (NoWait, 
e-mail is sent as soon as 
the event occurs) for the 
listed events. If Enable is 
selected, the check interval 
can be set in hours and /or 
minutes (0, 15, 30, or 45).

Attach Info. Select whichever information is to be included in the 
E-mail.

Comment... Set up to four lines of text to be included with the E-mail 
as comments.

Authentication... Used to set the following security information:

User SMTP Authentication Enable/disable SMTP 
authentication.

User ID Set the user ID for 
authentication.

User Password Set a password for 
authentication.
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Item Comments
Others... Set the following Items:

SMTP Port Number Set the port number of 
SMTP (default is 25).

Reply-To Address Set the E-mail address used 
for the [Reply -To] fi eld in 
the mail header.

E-mail (Receive) Tab (Network Device Setup)  
The print server supports an e-mail reception function (POP3) allowing the Ilumina 
to print PDF and text fi les attached to e-mails. 

Not all Iluminas support this function. If the POP tab is not displayed, your Ilumina 
does not support this function.

Item Comments
Use POP Receive Enable/disable receiving E-Mail via POP3. 
POP3 Server Set the IP address or host name of the POP3 server. 
POP3 Server UserID Set User ID for POP3 server. 
POP3 Server Password Set a password for the POP3 server.  
POP Detail… Set the following:

Use APOP Select if you want to use APOP.
POP3 Port Number Set the port number for APOP 

(default is 110).
Mail Polling Time. Set interval to retrieve E-Mail(s) 

from the POP3 server. Selectable 
values, OFF, 1min, 5min (default), 
10min, 30 min, 60 min.

Use SMTP Receive Enable/disable SMTP receive.
Domain Filter… Set the following:

Use Domain Filter Enable/disable domain fi ltering.
Filter Policy Select ACCEPT (the default) or 

DENY.
Domain Filter Defi ne up to fi ve domain fi lters.
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SNTP Tab (Network Device Setup)  

Item Comments
Use SNTP Enable/disable SNTP (Simple Network Time Protocol).
NTP Server 1 Address  Set the IP address or host name for NTP Server 1.
NTP Server 2 Address Set the IP address or host name for NTP Server 2.
Adjust Interval Set the interval for sending time update requests to the server. 

Select 1 hour (the default), 12 hours or 24 hours.
Local Time Zone Set the local time zone from -12:00 to +13:00. Minute interval is 

selectable from 00 (the default), 15, 30 or 45.
Daylight Saving When this is selected, one hour is added to the local time.

Maintenance Tab (Network Device Setup)

Item Comments
LAN Scale Select NORMAL (the default) or SMALL. 
IP Filter Setup…   The following items can be confi gured: 

Use IP Filter Enable/disable IP Filtering. Default is disabled.
Admin IP Address Enter the Ilumina’s IP Address.
IP Address Range Set up to 10 IP Filter address ranges: [IP Filter 

Range 1] through [IP Filter Range 10].
Printing Enable/disable printing of the specifi ed IP address 

range. Default is disabled.
Confi guration Enable/disable changing IP address ranges. Default 

is disabled.
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Item Comments
Service…            The following features can be selected by clicking their check box. 

• TCP/IP Protocol (enabled)
• NetBEUI Protocol (disabled)
• NetWare Protocol (disabled)
• EtherTalk Protocol (disabled)
• FTP Service (enabled)
• Use Telnet Service (enabled)
• Use Web Service (enabled)
• Use SNMP Service (enabled)
• Use POP3 Protocol (disabled)
• Use encrypted communications for confi guration data

SSL/TLS Tab (Network Device Setup)  
See chapter 3, “Utilities” for more information.

Item Comments
Encryption Strength Set the strength of encryption:

• Strong = highest security, slowest speed
• Standard = medium security, medium speed
• Weak = least security, fastest speed

Self-signed 
Certifi cate  

For IPP encryption within an organization’s internal network (intranet).
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Item Comments
Create Certifi cate… When Self-signed Certifi cate is selected, the following items are 

confi gured:
Common Name The Ilumina’s IP Address appears here.
Organization Enter the name of your organization.
Organization Unit Optional. Allows you to enter a 

subdivision or department name.
Locality Enter the name of the city where the 

organization is located.
State/Province Enter the state or province where the 

organization is located.
Country/Region Enter the country or region where the 

organization is located.
Key Exchange Method Select RSA (the default) or Diffi e-

Hellman(DSS).
Key size Select 512, 1024 (the default), or 2048 

bits.
Term of Validity Enter a starting and ending date (month/

date/year) for which the certifi cate is 
valid.

CA-signed 
Certifi cate… 

Used for web encryption to provide security when printing over the 
internet. Requires an outside certifi cation service which must be 
purchased separately.

Create Certifi cate… When CA-signed Certifi cate is selected, the following items are 
confi gured:
Common Name The Ilumina’s IP Address appears here.
Organization Enter the name of your organization.
Organization Unit Optional. Allows you to enter a 

subdivision or department name.
Locality Enter the name of the city where the 

organization is located.
State/Province Enter the state or province where the 

organization is located.
Country/Region Enter the country or region where the 

organization is located.
Key Exchange Method Select RSA (the default) or Diffi e-

Hellman(DSS).
Key size Select 1024 (the default) or 2048 bits.
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IEEE802.1X Tab (Network Device Setup)

Item Comments
Use IEEE802.1X Enable/disable
EAP Type The following items can be confi gured:

EAP-TLS Use EAP-TLS protocol
PEAP Use EAP-TLS protocol

Use SSL/TSL Enable/disable
Authenticate server Enable/disable
Certifi cate Client certifi cate File:

Password:
Options to Import, Delete, View

CA certifi cate File:
Password:
Options to Import, Delete, View

 • Setup by HTTP 
Launches the default browser in your environment to access the selected printer’s 
web page.

  • Setup by TELNET
Launches the TELNET application in your environment to access the selected 
printer’s TELNET port.

	 The TELNET application is not included as part of the print server 
package. Install the TELNET package on to your system. For further 
information, see your Windows manual.

 • Reset
Resets the selected network interface card.

    • Test Print
Prints the self-diagnostic test pages.

 • IP Address Setup
Sets the static IP address of the network interface card manually. If you only use 
TCP/IP and the print server has not yet been confi gured, occasionally it may not 
be displayed on AdminManager. You can confi gure the IP address of the print 
server by this function.
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1. Enter the [Ethernet Address] (MAC Address) and the [IP Address], then click 
[OK].

	 The Ethernet (MAC) Address is displayed under “General Information” on 
the self-diagnostic test printout (see “Self Diagnostic Test” in chapter 1 for 
details). 

2. AdminManager asks whether you want to initialize the network interface card 
or not. Select [Yes].

	 Even if you select [No] here, the IP address that you set can be used after 
turning the Ilumina OFF and ON. The requirement to turn your Ilumina OFF 
and ON is dependent on the network interface card.

Option Menu

•  Use TCP/IP Protocol
If this item is selected, AdminManager uses TCP/IP protocol to search/confi gure 
network interface cards.

• Use IPX/SPX Protocol  
If this item is selected, AdminManager uses IPX/SPX protocol to search/
confi gure network interface cards.

• Environment Setup   
Set environment items such as broadcast addresses for TCP/IP protocol, network 
addresses for NetWare protocol and Time Out.
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TCP/IP Tab (Environmental Setup) 

  

Item Comments
Use TCP/IP Protocol Enable/disable TCP/IP protocol. The default is enabled. If disabled, 

the search will not be carried out using TCP/IP. 
Set Broadcast Address Set broadcast addresses that are used to search Xanté network 

interface cards using the TCP/IP protocol.
Add  Click [Add] to add the address to the list in the box.
Delete Select an address in the box, then click [Delete] to remove it.

NetWare Tab (Environmental Setup) 

Item Comments
Use NetWare Protocol Enable/disable NetWare protocol. The default is enabled. If disabled, 

the search will not be carried out using NetWare. 
Auto Search If [Auto Search] is selected (the default), AdminManager will search 

all networks that it can detect.
Set Network Number Set network addresses that are used to search the network interface 

cards via NetWare protocol.For large networks with many NetWare 
fi le servers, specify the network address to which the network card 
belongs.

Add Click to add the network number you have entered to the list box.
Delete Select an address in the box, then click [Delete] to remove it.
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Timeout Tab (Environmental Setup)  

Item Comments
Obtain the printer name via 
SNMP

Enable/disable.

Community name Set a community name.
Add Click to add the entry to the list box.
Delete Select an entry in the list box, then click [Delete] 

to remove it.

Timeout Tab (Environmental Setup)  

Item Comments
Set Timeout: Printer Search [Search Every (20-180sec)] 

Set the response waiting time from the network card in 
seconds. Default is 30 seconds.

Set Timeout: Data Send/Receive [Time Outs (1-60sec)] 
Set time out between AdminManager and the network 
interface card in seconds. Default is 5 seconds.

[Retry (1-5)]
Sets how many times AdminManager will retry to 
transmit/receive data to/from the network interface 
card. Default is 3 retries.

Help Menu

• About
Provides software Version and copyright information.
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Chapter 3 - Utilities 
This chapter covers the following:

• PrintSuperVision Management Utility

• Xanté LPR Printing Utility

Utilities:  PrintSuperVision Management Utility  
PrintSuperVision is a web-based application for managing printing devices connected 
to a network. It consists of two parts:

• A web application based on Microsoft web server (Internet Information Server, 
IIS or Personal WEB Server, PWS), that provides the user interface.

• A monitoring program (PrintSuperVisor) that runs all the time, collecting data 
and saving it in a database for statistical reports and sending E-mail alerts based 
on the saved confi guration.

PrintSuperVision requires the .NET environment to be installed on the PC on which it 
runs. The supplied installer will install this if necessary.

PrintSuperVision’s Main Functions 
• Maintaining the list of printing devices and organizing them in logical groups.

• Initially discovering and confi guring printers and digital color presses connected 
to the network.

• Locating printers and digital color presses visually on maps.

• Monitoring devices over time and saving data for statistical reports.

• Sending e-mail alerts when selected events occur that affect the functionality of 
the Ilumina.

• Creating statistical reports about usage of printers and digital color presses.

• Tracking maintenance data related to printers and digital color presses.

• Integrating with Xanté’s on-line web support.

System Requirements  

Windows
The main PrintSuperVision application can be installed in any of the following 
Windows systems.
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Operating
System

Service
Pack

IIS MDAC and .NET 
Framework

Windows XP 
Professional

SP2 IIS installed as an 
option. Available on 
the Windows XP CD
Install IIS before 
installing .NET 
farmework.

MDAC and .NET framework 
available for download from 
Microsoft. DMAC 2.8 and 
.NET framework version 
1.1 included as part of PSV 
install.

Windows 2000
Professional

SP4 Internet Service 
Manager included in 
the OS.
Available in the 
Windows 2000 CD, 
Install IIS before 
installing .NET 
framework.

MDAC and .NET framework 
available for download from 
Microsoft.
DMAC 2.8 and .NET 
farmework version .1 
included as part of PSV 
install.

Windows 2000 
Server / Advanced 
Server /
Datacenter Server

Windows XP Home SP2 Works only with 
PSV Embedded Web 
Server, available 
in the PSV Install 
Package.

MDAC and .NET framework 
available for download from 
Microsoft.
DMAC 2.8 and .NET 
framework version 1.1 
included as part of PSV 
install.

Supported Browsers 

• Internet Explorer (IE) 6.0 and above. 

• Firefox 1.5 and above.

• Netscape Navigator 8.0 and above. 

• Opera 8.5 and above. 

The following options must be enabled in Windows:

• TCP/IP. 

• SNMP

• Anonymous access for IIS 

• Administrative privileges for the system
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• In NTFS systems, the folder should have Read/Write access

The PrintSuperVision application can be accessed from any Windows, Macintosh, 
Unix, or Linux  desktop that supports any of these browsers. 

Supported Printers and Digital Color Presses 
PrintSuperVision provides general management information for Xanté and non-Xanté 
printers and digital color presses connected to the network.

For Xanté Iluminas, additional details, reports, and added features are available. 

While the Ilumina properties are displayed in PrintSuperVision, only a few of these 
settings can be set. For setting any other Ilumina settings, a hyperlink to the Ilumina’s 
web page is provided in PrintSuperVision.

Installing PrintSuperVision 

	 Installation requires administrator privileges.

1. Insert the Drivers CD provided with your printer into the CD-ROM drive and 
wait for it to autorun.

 If the Menu Installer does not start automatically, click [Start] → [Run] → 
[Browse]. Browse to your CD-ROM and click [INSTALL.EXE] → [Open] → 
[OK].

2. Click [Next] to accept the Software License Agreement, then select your 
language.

3. Click [Custom Install].

4. Click [Network Software].

5. Click [Administration Tools].

6. Click [PrintSuperVision]. The installation Wizard opens.

7. Follow the on-screen instructions.
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 – In the “Edit Data” window, you can specify a port number for    
   PrintSuperVision (the default is 80).

 – When the installation ends, the “Setup complete” window appears.

8. Click [Finish].

Running PrintSuperVision 

To run PrintSuperVision Server:

• Click [Start] → [Programs] → [PrintSuperVision] → [PrintSuperVision]

 or

• Double-click the [PrintSuperVision] icon on the desktop for the PrintSuperVision 
server.

To run PrintSuperVision Client

1. Open your web browser.

2. Enter the address

 http://[fi ll in the server IP address or host name]/PrintSuperVision.

3. Or, If you changed the port number, enter the address with the port number 
included, e.g.:

 http://172.168.20.127/PrintSuperVision:8080.

Help 
PrintSuperVision has an on-line help facility.

Uninstalling PrintSuperVision
To uninstall PrintSuperVision, either  use the utility’s uninstall program or use the 
Windows Add/Remove Programs feature.

The PrintSuperVision Uninstall Program 
To run the uninstall program:

• Click [Start] → [Programs] → [PrintSuperVision] → [Uninstall 
PrintSuperVision]
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The Windows Add/Remove Program  
To run the Windows Add/Remove Program:

1. Click [Start] → [Settings] → [Control Panel].

2. Double click [Add or Remove Programs].

3. Scroll to [PrintSuperVision], and select it.

4. Click [Add/Remove].

5. When the uninstallation is complete, close [Add/Remove Programs].

In some cases, an empty [Xanté/PrintSuperVision/] directory may be left behind. If 
so, you need to delete the directory manually.

Utilities:  LPR Utility  
The Xanté LPR Utility is a utility that allows sending data to Iluminas connected 
to the network via TCP/IP. The utility redirects printing data to the LPR port of the 
specifi ed IP address.

System Requirements 
Windows DP or 2000 with TCP/IP protocol installed and Xante printers that support 

TCP/IP.

Installing LPR Utility 
Installation consists of three steps:

• Step 1: Load the Ilumina Driver

• Step 2: Install the Utility

• Step 3: Add the Ilumina to the Utility

Step 1: Install the Ilumina Driver
Install the Ilumina driver on local port LPT1.

1. Insert the Drivers CD provided with your Ilumina into the CD-ROM drive and 
wait for it to autorun.
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 If the Menu Installer does not start automatically, click [Start] → [Run] → 
[Browse]. Browse to your CD-ROM and click [INSTALL.EXE] → [Open] → 
[OK].

2. Click [Next] to accept the Software License Agreement, then select your 
language.

3. Click [Custom Install].

4. Click [Printer Driver Installer].

5. Select [Local printer], then click [Next].

6. Select [LPT1:], then click [Next].

7. Follow the on-screen instructions to complete the driver installation. The driver 
installs and the program returns to the Software Installation window.

Step 2: Install The Utility

 • Installation on Windows XP, 2000 and NT4.0 requires administrator   
  privileges.

 • TCP/IP protocol must be installed in your Windows system. To install the  
   TCP/IP protocol into your Windows system consult your Windows manual.

1. Click [Network Software].

2. Click [Installation/Confi g]

3. Click [LPR Utility].

4. When the “Welcome” window appears, click [Next].

5. Click [Yes] to accept the Software License Agreement.

6. Verify the [Destination Folder] and [Spool Folder], and click [Next].

7. Select the startup method you wish to use to launch the utility when Windows 
boots:

 – To automatically launch the program in an open window, select [Register in  
   Startup].
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 – To automatically launch the program minimized as an icon, select [Launch as  
   minimized]. To open the “LPR UTILITY” window, click the icon.

8. Click [Next].

9. Verify the program folder name and click [Next]. The installation starts.

10. When the installation ends, the “Setup complete” window appears.

11. Check [Yes, I want to launch LPR Utility now].

12. Click [Finish]. The utility starts.

Step 3: Add The Ilumina to the Utility

1. With the utility open, click the [Remote Print] pull-down menu and select [Add 
Printer].

2. Fill in the [IP address] fi eld:

 – If you know the IP address, simply type it in, or if you don’t know the IP 
address, click [Discover] and wait while the program searches the network for 
the Ilumina. When the “Discovery” window appears, click the Ilumina in the 
box, then click [OK].

3  Click [OK]. The Ilumina is added to the main window.

 Uninstalling the Utility 

 If a fi le that has been added after installation exists in the folder to install 
the utility or the folder to spool, you cannot delete the folder. Delete any 
unwanted fi les before running [Uninstall LPR Utility].

1. Exit the utility: right-click the LPR Utility icon in the system tray and click 
[Exit].



Ilumina Network and Confi guration Guide  43

2. Select [Start] → [Programs] → [Xanté] → [LPR Utility] → [Uninstall LPR 
Utility].

3. Click [Yes] when the “Confi rm File Deletion” window appears. Deletion of the 
LPR utility starts.

4. When the “Uninstall Complete” window appears, click [OK].

◊◊◊
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Chapter 4 - Security Features 
This chapter covers the following:

• Overview

• IPP Encryption   

• Web Encryption  

• Unused Protocols 

Security Features:  Overview
This section covers the security features provided with the print server, including:

• SSL/TLS 

• Disabling unused protocols 

In addition, you can enable

• IP Filtering (see “Maintenance Tab [Network Device Setup]” in chapter 2))  

• E-mail Domain Filtering for Domains 1 through 5 (see “SMTP” in chapter 2).  

SSL/TLS      
Your print server incorporates both SSL (Secure Sockets Layer) Version 3.0 and 
TLS (Transport Layer Security) Version 1.0 to encrypt communications between 
computers and your Ilumina.

Two types of encryption are available: IPP encryption and Web encryption:

IPP Encryption    

• For printing via internal networks

• Uses Self-Signed Certifi cate 

• For Windows XP and 2000 only  

Web Encryption   

• For printing over the internet

• Uses certifi cate signed by an external Certifi cation Authority service (This 
service is not provided as part of the Fast Ether 8200e print server.) 
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• Requires Microsoft Internet Explorer Version 5.5 and higher or Netscape 
Navigator version 6.2 and higher.  

	 Other browsers which support SSL/TLS may work, but no guarantees are 
offered for them. 

Web Encryption Prevents

• Wiretapping    

• Spoofi ng (impersonating)
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Summary of SSL/TLS Encryption Functions      

Item Specifi cations Default
Security Type • SSL Version 3.0

• TLS Version 1.0b
NAa

Key Exchange
(Public Key Size)

• RSA (512, 1024, or 2048 bits)
• DH (512, 1024, or 2048 bits)

RSA, 1024 bits

Encryption Algorithm
(Symmetric Key Size)

• RC4 (40 or 128 bits)
• DES (40 or 56 bits)
• 3DES (168 bits)
• AES (128 or 256 bits)

NAa

Hash Method • MD5
• SHA-1

SHA-1

Authentication Method 
One-way authentication

(PC → Ilumina) NAa

Certifi cate • Self-Signed Certifi cate  

• Certifi cate signed by a
  Certifi cate Authority

Self- Signed

a. NA = Not applicable.

Unused Protocols  
Protocols which are not used by your system can be turned off to prevent 
unauthorized access through them.

Security Features:  IPP Encryption  

Setting Up IPP Encryption 

Process Summary

Step 1: Create the Self-Signed Certifi cate

Step 2: Enable IPP Printing at the client stations

Step 1:  Create the Self-Signed Certifi cate 

	 A self-signed certifi cate certifi es that the Ilumina to be connected exists at the 
specifi ed IP Address and contains the specifi ed certifi cate information. If the 
Ilumina’s IP Address changes, the certifi cate will be invalid and will have to be 
redefi ned by the administrator. 
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Using the Web Browser  

• Requires Microsoft Internet Explorer Version 5.5 and higher or Netscape 
Navigator version 6.2 and higher.

	 Other browsers which support SSL/TLS may work, but no guarantees are 
offered for them.

1. Open the web browser.

2. Type in the Ilumina’s IP Address (refer to the self-diagnostic printout–see 
“Self-Diagnostic Test” in chapter 1) and press the Enter key.

3. Click [Administrator Login], then enter
– your [User name]
 (the default is root)
– [Password]
 (the default is the last six digits of the MAC [Ethernet] Address, minus any  
 punctuation).

4. Click the [Security] tab.

5. On the left side, click [Cipher (SSL/TLS)]. The “Encryption of Confi guration 
and Print” window appears.

6. Change [SSL/TLS] to ON.

7. To change the cipher strength setting, click [Cipher Level Settings] and make 
your selection, then click [OK].
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	 The default setting is Standard. Changing the setting to Strong will increase 
security, but slow down the speed. Changing the setting to Weak gives the 
fastest speed, but provides the least security.

8. Make sure [Using self-signed Certifi cate] is selected (the default).

9. Scroll down and under the [Value] column enter the information to be included 
in the certifi cate:

a. To change the Key Exchange method or the size of the Public Key to be 
attached with the certifi cate, scroll down to the bottom and click [Change 
these settings].

b. Select the desired method and key size, then click [OK].
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10. When done, click [OK] to send the setting to the print server. A Value List 
window appears.

11. Check the settings. If they are correct, click [OK]. If you need to make 
changes, click [Cancel], make any needed changes and click [OK] to send the 
revised information to the print server.

12. Click [OK]. The “Security Alert” window appears.

13. Click [Yes]. The “Connect to” window appears.

14. Enter your User Name and Password, then click [OK]. The “Encryption Status” 
window appears.

15. Check the settings, then click [Submit].

Using AdminManager  

1. Launch the AdminManager utility:

 – From the Drivers CD supplied with your Ilumina:
   [Next] → select language → [Custom
   Install] → [Network Software] → [Installation/
   Confi g] → [Admin Mgr / Quick Setup] → select
   language → [Network Device Standard Setup] → [Execute from CD-ROM].

 – From your desktop (if you installed the utility from the CD):
   [Start] → [Programs] → [Network Setup Utility] → [AdminManager].

2. Click the Ilumina to confi gure from the list.

3. Click [Setup] → [Network Device Setup]. The “Password” window appears.

4. Enter your password, then click [OK].
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5. Click the [SSL/TLS] tab.

Item Comments
Encryption Strength Set the strength of the encryption. Switching to Strong provides 

greater security, but slower speed. Switching to Weak provides the 
fastest speed, but the least security.

Self-signed Certifi cate The default type of certifi cate.
Create Certifi cate… With self-signed certifi cate selected, set the following.

Common Name Enter the IP Address for the Ilumina.

Organization Enter a name for the organization.

Organizational Unit Optional. Enter a name to differentiate 
between divisions within an organization.

Locality Enter the name of the city where the 
organization is located.

State/Province Enter the name of the state or Province 
where the organization is located.

Country/Region Enter the name of the country or region 
where the organization is located.

Key Exchange method. Select RSA or DH. The default RSA ia 
recommended.

Key size Select 512, 1024, or 2048 bits. The default, 
1024 bits, is recommended.

Term of Validity Set a month/date/year and time range for 
which the certifi cate is valid

CA-signed Certifi cate Used to set up a CA certifi cate for internet printing. See “Using 
AdminManager” later in this chapter for more information.



Ilumina Network and Confi guration Guide  51

6. With [Self-signed Certifi cate] selected (the default), click [Create 
Certifi cate…].

7. Enter the appropriate information then click [OK]. A window appears listing 
the settings you have made.

8. Review the information entered, then click [OK] to accept it.

9. Wait for the following window to appear:

10. Click [OK]. The SSL/TLS tab window appears.

11. Click [Apply]. A window appears containing a summary of your certifi cation 
selection.

12. Click [OK].

13. Click [Yes]. The print server reboots with the new certifi cation settings 
engaged.

Step 2: Enable IPP Printing at Client Stations  

	 Client stations must have Windows XP or 2000 to use IPP Encryption 
printing.

Using the Web Browser  

• Requires Microsoft Internet Explorer Version 5.5 and higher or Netscape 
Navigator version 6.2 and higher.

	 Other browsers which support SSL/TLS may work, but no guarantees are 
offered for them.
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1.  Open the web browser.

2. Type in the Ilumina’s IP Address (refer to the self-diagnostic printout–see 
“Self-Diagnostic Test” in chapter 1) and press the Enter key.

3. Click [Administrator Login], then enter
– your [User name]
 (the default is root)
– your [Password]
 (the default is the last six digits of the MAC [Ethernet] Address, minus any 
punctuation).

4. Click the [Network] tab.

5. On the left side, click [IPP], then [Settings].

6. Select ENABLE for [IPP].

7. Click [Submit]

Using AdminManager  

1. Launch the AdminManager utility:

– From the Drivers CD supplied with your Ilumina:
[Next] → select language → [Custom Install] → [Network Software] → 
[Installation/ Confi g] → [Admin Mgr / Quick Setup] → select language → 
[Network Device Standard Setup] → [Execute from CD-ROM].

 – From your desktop (if you installed the utility from the CD):
[Start] → [Programs] → [Network Setup Utility] → [AdminManager].

2. Click the Ilumina to confi gure from the list.

3. Click [Setup] → [Network Device Setup]. The Password window appears.

4. Enter your password, then click [OK].

5. Click the [Maintenance] tab.
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6. Click [Service…].

7. Click the box beside [Use IPP Service] to select it, then click [OK].

8. Click [Apply]. A window appears containing a summary of your certifi cation 
selection.

9. Click [OK].

10. Click [Yes]. The print server reboots with the new certifi cation settings 
engaged.
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Printing Using IPP Encryption 

1. Open the fi le to be printed in your application.

2. Click [File] → [Print].

3. Select the created IPP encrypted printer (e.g., Model 1234 on
https://155.37.177.60) from the [Select Printer] list, then click [Print].

Security Features:  Web Encryption  

 CA (Certifi cation Authority) encryption requires an outside certifi cation 
service. It can take about 2 weeks to get a certifi cate issued. The certifi cate is 
guaranteed by the CA service.

The issue time, price and available services depend on the CA you choose.

Setting Up Web Encryption 

Process Summary

Step 1: Apply to a CA service for a certifi cate.

Step 2: Install the certifi cate on the print server.

Step 1: Apply for a CA Certifi cate

Using Web Browser 

• Requires Microsoft Internet Explorer Version 5.5 and higher or Netscape 
Navigator version 6.2 and higher.

	 Other browsers which support SSL/TLS may work, but no guarantees are 
offered for them.

1. Open the web browser.

2. Type in the Ilumina’s IP Address (refer to the self-diagnostic printout–see 
“Self-Diagnostic Test”) and press the Enter key.
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3. Click [Administrator Login], then enter
– your [User name]
(the default is root)
– [Password]
(the default is the last six digits of the MAC [Ethernet] Address, minus any 
punctuation).

4. Click the [Security] tab.

5. On the left side, click [Cipher (SSL/TLS)]. The “Encryption of Confi guration 
and Print” window will appear.

6. Change [SSL/TLS] to ON.

7. To change the cipher strength setting, click [Cipher Level Settings] and make 
your selection, then click [OK].
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	 The default setting is Standard. Changing the setting to Strong will increase 
security, but slow down the speed. Changing the setting to Weak gives the 
fastest speed, but provides the least security.

8. Click [Using a Certifi cate which a Certifi cation Authority signed].

9. Scroll down and type in the information to be used in the certifi cation:

a. To change the Key Exchange method or the size of the Public Key to be 
attached with the certifi cate, scroll down to the bottom and click [Change 
these settings].

b. Select the desired method and key size, then click [OK].
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10. Click [OK]. The “Value List” window appears.

11. Check the settings, then click [OK].

12. Wait for the “Send the CSR to a Certifi cation Authority” window to appear.

13. Copy the text in the box starting with “BEGIN CERTIFICATE SIGNING 
REQUEST” and ending with “END CERTIFICATE SIGNING REQUEST”, 
and submit it to your selected Certifi cation Authority service, following their 
instructions.

14. Click [OK].

 It can take about 2 weeks to get a certifi cate issued. While you are waiting 
to receive your completed certifi cate, do not make any changes to the print 
server settings as this can invalidate the certifi cate!

Using AdminManager 

1. Launch the AdminManager utility:

– From the Drivers CD supplied with your Ilumina: 
[Next] → select language → [Custom Install] → [Network Software] → 
[Installation/ Confi g] → [Admin Mgr / Quick Setup] → select language → 
[Network Device Standard Setup] → [Execute from CD-ROM]

– From your desktop (if you installed the utility from the CD):
[Start] → [Programs] → [Network Setup Utility] → [AdminManager].

2. Click the Ilumina to confi gure from the list.

3. Click [Setup] → [Network Device Setup]. The Password window will appear.
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4.  Enter your password, then click [OK].

5. Click the [SSL/TLS] tab.

Item Comments
Encryption Strength  Set the strength of the encryption. Switching to Strong provides 

greater security, but slower speed. Switching to Weak provides the 
fastest speed, but the least security.

Self-signed Certifi cate  The default type of certifi cate. 
CA-signed Certifi cate  Click to set up a CA certifi cate for internet printing.
Create Certifi cate… Click to set up the CA certifi cate, including

Common Name Enter the IP Address for the Ilumina.

Organization Enter a name for the organization.

Organizational Unit Optional. Enter a name to differentiate 
between divisions within an 
organization.

Locality Enter the name of the city where the 
organization is located.

State/Province Enter the name of the state or Province 
where the organization is located.

Country/Region Enter the name of the country or region 
where the organization is located.

Key Exchange method. Select RSA or DH. The default RSA ia 
recommended.

Key size Select 512, 102, or 2048 bits. The 
default, 1024 bits, is recommended.
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6. Click [CA-signed Certifi cate], then click [Create Certifi cate].

7. Enter the appropriate information then click [OK]. A window appears listing 
the settings you have made.

8. Review the information entered, then click [OK] to accept it.

9. Wait for the “View the CSR data” window to appear.

10. Copy the text in the box starting with “BEGIN CERTIFICATE SIGNING 
REQUEST” and ending with “END CERTIFICATE SIGNING REQUEST”, 
and submit it to your selected Certifi cation Authority service, following their 
instructions.

11. Click [OK].

 It can take about 2 weeks to get a certifi cate issued. While you are waiting 
to receive your completed certifi cate, do not make any changes to the print 
server settings as this can invalidate the certifi cate.

Step 2: Install the Certifi cate 
Once you receive your certifi cate from the CA, you must install it, using either the 
web browser or the AdminManager utility. Keep the certifi cate text handy as you will 
be prompted to copy and paste it into the program.
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 You can install only one certifi cate to one Ilumina. If the issued CA certifi cate 
is an intermediate certifi cate, install it on the client PC.

Using Web Browser  

• Requires Microsoft Internet Explorer Version 5.5 and higher or Netscape 
Navigator version 6.2 and higher.

	 Other browsers which support SSL/TLS may work, but no guarantees are 
offered for them.

1. Open the web browser.

2. Type in the Ilumina’s IP Address (refer to the self-diagnostic printout–see 
“Self-Diagnostic Test”) and press the Enter key.

3. Click [Administrator Login], then enter

 – your [User name]
(the default is root)

 – [Password]
(the default is the last six digits of the MAC [Ethernet] Address, minus any 
punctuation).

4. Click the [Security] tab.

5. On the left side, click [Cipher (SSL/TLS)].

6. Copy the certifi cate text sent by the CA service, starting with “BEGIN 
CERTIFICATE” and ending with “END CERTIFICATE”, and paste it into the 
“Paste your signed certifi cate(PEM) …” box.
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7. Click [Submit]. The “Security Alert” window appears.

8. Click [Yes], then enter your User name and Password and click [OK].

9. Check the Security tab window to ensure that the certifi cate installation is 
competed and that SSL/TLS is turned on.

Using AdminManager  

1. Launch the AdminManager utility:

 – From the Drivers CD supplied with your Ilumina:
[Next] → select language → [Custom Install] → [Network Software] → 
[Installation/ Confi g] → [Admin Mgr / Quick Setup] → select language → 
[Network Device Standard Setup] → [Execute from CD-ROM].

 – From your desktop (if you installed the utility from the CD):
[Start] → [Programs] → [Network Setup Utility] → [AdminManager].

2. Click the Ilumina to confi gure from the list.

3. Click [Setup] → [Network Device Setup]. The Password window appears.

4. Enter your password, then click [OK].

5. Click the [SSL/TLS] tab.
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6. Click [Install Certifi cate…].

7. Copy the certifi cate text sent by the CA service, starting with “BEGIN 
CERTIFICATE” and ending with “END CERTIFICATE”, and paste it into the 
box, then click [Install].

8. Wait until the completion acknowledgement window appears, then click [OK]. 
The SSL/TLS tab window will appear.

9. Click [Apply]. A window will appear summarizing the changes.
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10. Click [OK].

11. Click [Yes]. The print server will reboot with the new certifi cation settings 
engaged.

Printing Using Web Encryption  

	 Requires Microsoft Internet Explorer Version 5.5 and higher or Netscape 
Navigator version 6.2 and higher. Other browsers which support SSL/TLS 
may work, but no guarantees are offered for them.

To make connection with the encrypted Ilumina:

1. Open your web browser.

2. Enter the Ilumina’s IP address as follows (be sure to include the s after “http”.:

 Internet Explorer
In the [Address] fi eld, enter https://<Ilumina’s IP Address>.

 Netscape Navigator
In the [Location/Position] fi eld, enter https://<Ilumina’s IP Address>.

3. Press the ENTER key.

Security Features:  Unused Protocols  

Disabling Unused Protocols 
Disabling unused protocols prevents access to the print server through those 
protocols.
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The easiest way to disable unused protocols is to use the Web Browser.

1. Open the web browser.

2. Enter the print server’s IP Address:

 Internet Explorer
Enter the print server’s IP Address in the [Address] fi eld.

 Netscape Navigator
Enter the print server’s IP Address in the [Location/Position] fi eld.

3. Press the ENTER key. The Ilumina Status window appears.

	 You also can launch the web browser from within the AdminManager utility. 
To do this, highlight the appropriate print server, then click [Setup] → [Setup 
by HTTP]:

4. Click the [Security] tab.

5. The “Protocol ON/OFF” window opens.

6. Here you can set the various available protocols to enable or disable.

7. When done, click [Submit].

◊◊◊
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Chapter 5 - Printing from Microsoft Windows 
This chapter provides guidelines on how to print over the network from various 
Microsoft Windows operating systems. There are numerous ways of printing from 
Windows and the exact set-up will vary depending upon your environment. There 
are also numerous versions of Windows, which can be confi gured as either a client, 
server or both.

Although there are many variants of Windows, the principles of network printing 
are the same. Microsoft provides on-line help with all of their operating systems and 
this is a good reference point for the exact details of each confi guration option within 
Windows

This section consists of the following:

• Overview)

• Using TCP/IP Protocol 

• Using NetBEUI Protocol 

	 For information on IPX (Novell NetWare), see “Printing from Novell 
NetWare” in chapter 6.

Printing from Windows:  Overview
This chapter provides guidelines on how to print  over the network from various 
Microsoft Windows operating systems. There are numerous ways of printing from 
Windows and the exact set-up will vary depending upon your environment. There 
are also numerous versions of Windows, which can be confi gured as either a client, 
server or both.

Although there are many variants of Windows, the principles of network printing 
are the same. Microsoft provides on-line help with all of their operating systems and 
this is a good reference point for the exact details of each confi guration option within 
Windows.

The network Ilumina supports the following protocols that can be used in conjunction 
with the Windows operating system:

• TCP/IP 

• NetBEUI 

• IPX (Novell NetWare)  
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Printing from Windows:  Using TCP/IP Protocol  

Installation Overview
There are a number of options available when printing using TCP/IP for Windows.

Windows Version Method
XP
2000

LPR Utility
Microsoft LPRa

Port 9100a

IPPa

Me
98

LPR Utility

NT 4.0 LPR Utility
Microsoft LPRa

Although there are some differences in confi guration options between the various 
Windows platforms, the procedure for printing using TCP/IP is the same.

Step 1: Ensure that the TCP/IP protocol has been installed in Windows. This can be 
confi rmed by checking the network settings from within the Control Panel. 
If TCP/IP has not been installed refer to “Installing TCP/IP Protocol” later in 
this chapter.

Step 2: If not already done, a suitable IP address, Subnet Mask and Gateway 
address should be confi gured. The current addresses appear under “TCP/
IP Confi guration” on the Self-Diagnostic test printout (see “Self-Diagnostic 
Test” in chapter 1). It is vital that the IP address entered is unique and valid. 
Entering an incorrect IP address may cause severe network problems. Please 
check the address with the network administrator. To change the addresses, 
see “Confi guring the IP Address, Subnet Mask and Gateway” later in this 
chapter.

Step 3: Confi gure Windows to print to the network Ilumina. See “Confi guring 
Windows to Print to the Network Ilumina” later in this chapter.

	 If your network environment uses domain names, DNS should be enabled 
and confi gured on your system. However, this step is not essential to enable 
network printing.

Step 4: Restart your computer.
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Installing TCP/IP Protocol
If TCP/IP protocol is not already installed on your computer, follow the instructions 
below to install it.

Installing TCP/IP Protocol Windows XP  

	 The Windows XP installation CD-ROM may be required to complete the 
installation.

1. Click [Start] → [Control Panel].

2. Click [Network and Internet Connection] → [Network Connection].

3. Double-click [Local Area Connection] and click [Properties] in the “Location 
Area Connection Status” window.

4. If the [Internet Protocol (TCP/IP)] is not listed, click [Install.].

5. In the “Select Network Component Type” window, click [Protocol] → [Add].

6. In the “Select Network Protocol” window, click [Internet Protocol (TCP/IP)] 
→ [OK].

7. Follow the on-screen instructions to fi nish the installation.

Installing TCP/IP Protocol Windows  2000 

1. Click [Start]→ [Settings]→ [Network and Dial-up Connections].

2. Double-click the [Local Area Connection] icon

3. In the “Local Area Connection Status” window, click [Properties].

4. In the “Local Area Connection Properties” window, click [Install].

5. In the “Select Network Component Type” window, click [Protocol] → [Add].

6. In the “Select Network Protocol” window, click [TCP/IP Protocol] → [OK].

7. Click [Close].

8. Click [Close].
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Installing TCP/IP Protocol Windows NT 4.0  

	 The Windows NT 4.0 installation CD-ROM may be required to complete the 
installation.

1. Click [Start] → [Settings] → [Control Panel].

2. Double-click the [Network] icon.

3. In the” Network” window, click the [Protocols] tab.

4. If the [TCP/IP Protocol] is not listed, click [Add].

5. In the “Select Network Protocol” window, click [TCP/IP Protocol] → [OK].

6. Follow the on-screen instructions to fi nish the installation.

Installing TCP/IP Protocol Windows Me/98  

	 The Windows installation CD-ROM may be required to complete the 
installation.

1. Click the [Start] → [Settings] → [Control Panel].

2. Double-click the [Network] icon.

3. In the “Network” window, click [Confi guration Panel].

4. If the [Client for Microsoft Networks] is not listed, click [Add].

5. In the “Select Network Component Type” window, click [Protocol] → [Add].

6. In the “Select Network Protocol” window, click [Microsoft] from the list of 
manufacturers, then click [TCP/IP] from the list of network protocols.

7. Click [OK].

8. Follow the on-screen instructions to fi nish the installation.

Confi guring the IP Address, Subnet Mask, and Gateway   

First, Generate a Self-Diagnostic Test Printout with the Ilumina connected to the 
network and switched on, press the Test button on the print server for more than three 
seconds.
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The IP Address, Subnet Mask and Default Gateway appear under “TCP/IP 
Confi guration” on the fi rst page.

If these settings need to be changed, you can do so as follows.

Using Web Browser      

1. Open your web browser, then type the Ilumina’s IP address in the URL area 
and press the Enter key.

2. Click [Administrator Login] and enter your [User name] and [Password].

	 If you are not the administrator, you will need your administrator to help you 
with this.

3. Click the [Network] tab.

4. On the left side, click [TCP/IP].

5. Under [Step 2], click [Set IP Address manually].

6. When done making changes, click [OK].

7. Click [Submit] to send the changes to the print server.

Using AdminManager      

1. Launch the AdminManager utility.

 – If you installed the utility on your computer, click [Start] → [Programs] → 
[Xanté] → [Network Setup Utility] → [AdminManager].

 – To run it off the Drivers CD, see “Installing AdminManager”.

2. Select the appropriate network card, using the Ethernet (MAC) address to 
identify it, and click [Setup] → [Network Device Setup].

3. Click the [TCP/IP] tab and enter the values for the [IP Address], [Subnet Mask] 
and [Default Gateway].

4. Click [Apply].

5. Close the AdminManager utility.
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Confi guring Windows to Print to the Network Ilumina 

Confi guring Windows for Printing Windows XP           
Windows XP requires administrator privileges. With Windows XP, there are four 
options for printing using TCP/IP.

• Xanté LPR Utility

• Microsoft LPR*
* In order to use Microsoft LPR, it must fi rst be installed on your system.

Xanté LPR Utility 
Please follow the procedure described under “Installing LPR Utility”.

Microsoft LPR 

1. Click [Start] → [Settings] → [Control Panel] → [Iluminas and Other 
Hardware].

2. Click [Iluminas and Faxes].

3. Click [Add Ilumina], then click [Next].

4. Click [Local Ilumina attached to this computer].

5. Clear the [Automatically detect and install my Plug and Play Ilumina] check 
box, then click [Next].

6. Click [Create a New Port] and [Type Standard TCP/IP Port].

7. Click [Next]. “Welcome to the Add Standard TCP/IP Ilumina Port Wizard” 
appears.

8. Click [Next] and enter [Ilumina name or IP address], for example: 
172.168.1.31. If the example IP address is entered, the Port Name will default 
to IP_172.168.1.31.

9. Click [Next]. The “Additional Port Information Required” windows appears.

10. Under [Device Type], click [Custom] → [Settings].

11. Ensure [Protocol] is set to [LPR].

12. Ensure [Queue Name] is lp and [SNMP Status Enabled] is deselected.



Ilumina Network and Confi guration Guide  71

13. Click [OK].

14. Follow the on-screen instructions to fi nish the installation.

Confi guring Windows for Printing Windows 2000 
Windows 2000 requires administrator privileges. With Windows 2000, there are four 
options for printing using TCP/IP.

• Xanté LPR  

• Microsoft LPR  

Xanté LPR Utility  
Please follow the procedure described under “Installing Network LPR Utility”.

Microsoft LPR  

	 To use Microsoft LPR, it must fi rst be installed on your system.

1. Click [Start] → [Settings] → [Control Panel and Iluminas].

2. Open the [Iluminas] folder.

3. Double-click [Add Ilumina].

4. Click [Next].

5. Click [Local Ilumina] and clear the [Automatically detect my Ilumina] check 
box

6. Click [Next].

7. Click [Create a new port] and then [LPR Port].

8. Click [Next] and provide the following information:

a. In [Name or address of server providing LPD] enter the host name or 
Internet Protocol (IP) address of the host for the Ilumina you are adding.

b. In [Name of Ilumina or print queue on that server] type lp.

9. Follow the on-screen instructions to fi nish the installation.
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Confi guring Windows for Printing Windows NT 4.0  
NT 4.0 requires administrator privileges. With Windows NT 4.0, you have two 
options for printing using TCP/IP. They are:

• LPR Utility

• Microsoft LPR  

Xanté LPR Utility
Please follow the procedure described under “Installing LPR Utility”.

Microsoft LPR

	 In order to use Microsoft LPR, it must fi rst be installed on your system.

1. Click [Start] → [Settings] → [Control Panel] → [Iluminas].

2. Click [Add Ilumina].

3. Click [My Computer] → [Next].

4. Click [Add Port].

5. Click [LPR Port] → [OK].

6. In [Name or address of server providing lpd], type the host name or IP address 
of the host for the Ilumina you are adding.

7. In [Name of Ilumina or print queue on that server], type the logical Ilumina 
name “lp” and then click [OK].

8. Follow the on-screen instructions to fi nish the installation.

Confi guring Windows for Printing Windows Me/98  
When printing using TCP/IP, the Xanté LPR utility is the only option to use. See 
“Installing LPR Utility”.

◊◊◊



Ilumina Network and Confi guration Guide  73

Chapter 6 - Printing Using Macintosh 
The print server supports the Apple  Macintosh  AppleTalk environment.

This section consists of the following:

• Overview

• Self-Diagnostic Test Printout)

• Installing the Driver

• Printing from Macintosh: Overview 

Printing from Macintosh:  Overview
The print server supports the Apple® Macintosh® AppleTalk environment. This 
guide is for administrators and it should be read in conjunction with the relevant 
Macintosh manual. The latest Macintosh service packs should be installed.

Supported Versions 
Macintosh operating systems

• OS 9.1+

• OS 10.1

• 10.2x

• 10.3x

are supported, except the original version Mac OS X.

Printing from Macintosh:  Self-Diagnostic Test Printout  
The Ilumina server’s self-diagnostic test reports the Ilumina’s MAC Address 
(Ethernet address), required for Macintosh confi guration.

1. Turn the Ilumina on.

2. Press the print server Test button for more than three seconds and release.

The MAC Address appears on the fi rst page under “General Information.”
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The fi rst six digits of the MAC Address are the same for all XantéLAN print servers. 

The last six digits of the MAC Address are unique to each XantéLAN and are 
required to set up the print server for Macintosh.

Printing from Macintosh:  Installing the Driver   

MAC OS 9.1+  

1. Place the Drivers CD, supplied with your Ilumina, in the CD-ROM drive.

2. Double-click the icon that appears on the desktop.

3. Open the [MAC] folder.

4. Open the [Driver Installer] folder.

5. Open the folder for your language.

6. Double-click the [MAC Installer] icon.

7. Click [Continue].

8. Click [Accept] to accept the Software License Agreement.

9. Select the installation type:

 – To install the driver and all utilities, use the default [Custom Easy Install], 
and click [Install].

 – To install the driver only—or the driver plus your selection of utilities—
select [Custom Install] in the drop-down list. Click the boxes beside the items 
you wish to install, then click [Install].
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10. Click [Quit].

MAC OS 10.1  

1. Place the Drivers CD, supplied with your Ilumina, in the CD-ROM drive.

2. Double-click the icon that appears on the desktop.

3. Open the [MAC] folder.

4. Open the [Driver Installer] folder.

5. Open the folder for your language.

6. Double-click the [MAC Installer] icon.

7. Click [Continue].

8. Click [Accept] to accept the Software License Agreement.

9. Select [MAC OS X.1-X.2x Drivers] from the drop-down list, then click 
[Install].

10. Once the driver is installed, if you wish to install the PS Gamma Adjuster 
utility as well, select it from the drop-down list, then click [Install].

11. Click [Quit].

MAC OS 10.2x  

1. Place the Drivers CD, supplied with your Ilumina, in the CD-ROM drive.

2. Double-click the icon that appears on the desktop.

3. Open the [MAC] folder.

4. Open the [Driver Installer] folder.

5. Open the folder for your language.

6. Double-click the [MAC Installer] icon.

7. Click [Continue].

8. Click [Accept] to accept the Software License Agreement.



76  Ilumina Network and Confi guration Guidebb

9. Select [MAC OS X.1-X.2x Drivers] from the drop-down list, then click 
[Install].

10. Once the driver is installed, if you wish to install the Profi le Assistant (and/
or Print Job Accounting) utility as well, select it from the drop-down list, then 
click [Install].

11. Click [Quit].

MAC OS 10.3x  

1. Place the Drivers CD, supplied with your Ilumina, in the CD-ROM drive.

2. Double-click the icon that appears on the desktop.

3. Open the [MAC] folder.

4. Open the [Driver Installer] folder.

5. Open the folder for your language.

6. Double-click the [MAC Installer] icon.

7. Click [Continue].

8. Click [Accept] to accept the Software License Agreement.

9. Select [MAC OS X.3x Driver] from the drop-down list, then click [Install].

10. Once the driver is installed, if you wish to install the Profi le Assistant utility as 
well, select it from the drop-down list, then click [Install].

11. Click [Quit].

Printing from Macintosh:  Setting Up the Ilumina

OS 9.1+ 
Create the Desktop Ilumina. 

1. Activate Chooser from the Apple menu.

2. Select your model/Appletalk and highlight the Ilumina name (print server ID#).

OS 10.1 and Above     
In Mac OS 10 you use the Print Center to setup network Iluminas.
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1. Run the Print Server.

2. Click [Add Printer.]

3. Select [Appletalk].

4. From the [Printer Model] drop down menu, select your Ilumina model.

5. Click [Add].

6. Quit the Print Center.

◊◊◊
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Chapter 7 -        Troubleshooting
The network addresses used in this manual are shown for example only. Network 
addresses used in your installation must be generated from your own network.

• Network summary printout

• TCP/IP 

• NetBEUI 

• Mac 

Troubleshooting:  Network Summary Printout

Network summary does not print
• Confi rm that the NIC is installed correctly and turn the printer off and on again.

• Ensure the network cable is correctly connected.

• Connect to a different network segment, re-print the summary and see if this fi xes 
the problem.

EEPROM check registers an ERROR
• Confi rm that the NIC is installed correctly and turn the printer off and on again.

• Initialize the NIC.

Troubleshooting:  TCP/IP  

Ilumina Cannot Find the Network Interface Card.   
• Turn the Ilumina off and on again.

• Confi rm that the network interface is enabled on the Ilumina.

• Make sure there is a response to the interface card command.

• Make sure the network cable is correctly connected.

• Change the cable and try again.

• Run the Self-diagnostic test (with Ilumina on, press and hold the Test button on 
the print server for 3 seconds, then release it).

• Make sure that the IP Address, Subnet Mask and Gateway are correct.
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• Make sure that the TCP/IP protocol is set to Enable.

• Reset the network interface card to the factory default settings.

• If DHCP, BOOTP, and RARP are not used, ensure they have been set to Disable.

Cannot Print with LPR and FTP.    
• Turn the Ilumina off and on again.

• Make sure there is a response to the ping command.

• Make sure the network cable is correctly connected.

• Change the cable and try again.

• Make sure the host name and IP address are confi gured in the workstation.

• Make sure the Ilumina port name is confi gured in the workstation.

• There are three port names: lp, euc and sjis. Use lp by default as euc and sjis are 
specifi c to printers and digital color presses with PostScript available.

Incorrect User Name on the Banner Page.   
• If printing with lpr, the User name printed is unknown and the Filename printed 

is the Spool fi le name.

• If printing with FTP, the User name printed is the User name entered during 
FTP login and the File name printed is the Transmitted fi le name. If the Print 
Directory name is indicated in the put command, the File name is not printed. 
The Ilumina name printed is the Logical Directory name.

Troubleshooting:  NetBEUI

The Network Interface Card is not identifi ed   
• Turn the printer off for 15 seconds and then on again.

• Make sure the ntwork cable is correctly connected.

• Change the cable and try again.

• Make sure the Microsoft network client and NetBEUI have been added to the 
network section of the control panel.

• Make sure the NetBEUI protocol is set to Enable.
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• Make sure the factory setting of the work group name is PrintServer and the 
computer name is ML+ the last six digits of the MAC address.

• Make sure the computer name of the NIC is different from the computer name on 
the network.

Error writing to PRN1
• Make sure the printer is online.

• If there is an error message indicating the paper has run out, add more paper to 
cancel the error.

• Check whether another user is printing. Print ater the other user has fi nished.

Troubleshooting:  TCP/IP

Blank pages or garbled text printed
Symptoms:
When printing via a USB or TCP/IP connection, you receive blank pages or pages 
printed with a line of garbled text.

Cause:
This issue is normally caused by the data being sent ot the printer in binary format. 
The printer may not be able to understand data in this format, and therefore may print 
blank pages or garbled text.

Solution:
In your application’s print options, there may be an option to send data as ASCII. 
Choose this option, and print your document.

For example, in Adobe Photoshop 7 or Adobe Photoshop CS:

1. Click the fi le menu and select Print with Preview.

2. Click the box Show More Options.

3. From the pop-up menu, choose Output.

4. From the pop-up menu Encoding, choose ASCII.

Banner print is rotated by 90 degrees and printed at bottom of paper
Mac OS X 10.2.3 or Greater

Possible causes and solutions:



Ilumina Network and Confi guration Guide  81

Not enough RAM in the printer to process the print job. Try printing at a lower 
resolution.

Incorrect custom paper size being specifi ed. Ensure that the Custom Paper SIze in 
both the printer driver and your application are exactly the same.

Mac OS 10.2.3 - 10.2.8 only

The print job may have been rotated by your application. An anomaly in the core 
Mac OS X 10.2.x causes custom paper sizes to be incorrectly rotated by 90 degrees, 
the Ilumina PPD fi le implements a counter-rotation to solve this problem. However, 
some applications such as Quark Xpress or Macromedia Freehand may create their 
own PostScript code. For these applications, the customer paper size rotation issue 
does not apply.

In such cases, if the Ilumina PPD fi le is selected in Quark or Freehand’s print 
dialogue, the print job will be incorrectly rotated by 90 degrees.

The Ilumina printer driver contains a page rotation option - this may be used to fi x 
the program Alternatively, you may be able to rotate the page in your application 
program.

No printing or print queue stopped
Sysmptoms:
Upon sending a job to the printer, the job disappears completely and is not printed, or 
the job remains stalled in Printer Setup Utility (Print Center).

Cause:
The Ilumina PPD fi le has a dependency on a fi lter fi le. This fi lter fi le must be installed 
at the following locations.

 /Library/Printers/Xante/Filters/XTJAfi lter

If this fi le is deleted, or is not present on your computer, jobs will not be sent to the 
printer. This can happen if you deleted this fi lter fi le or if you copied a PPD fi le from 
another Mac and did not use the Ilumina installer.

Solution:
Run the install software supplied with your printer. This will install the CUPS fi lter 
fi le and allow normal printing.

◊◊◊
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Appendix:  The Ilumina Menu
Menu Basics  

Top Level Functions
The top-level Functions menus are:

• Confi guration (refer to Appendix B in the User’s Guide)       

• Print Information (refer to Appendix B in the User’s Guide)

• Print Secure Job (refer to Appendix B in the User’s Guide)

• Menus (refer to Appendix B in the User’s Guide)

• Admin Setup: password protected (see “Admin Setup later in this Appendix”)

• Calibration (see “Calibration Menu” later in Appendix)

• Print Statistics: password protected (see “Ilumina Statistics Menu” later in this 
Appendix)

Special Menu  
• Boot Menu (see “Ilumina Menu Boot Menu” later in this Appendix)

Ilumina Menu Overview 
The following tables summarize the Admin Setup, Calibration, Print Statistics, and 
Boot Menu trees.    

The remainder of the menus above are described in Appendix B of the on-line 
Ilumina User’s Guide.

Table Conventions Used  
• The menu trees are given to the lowest menu item level. Typically, this can be 

a parameter that can be set by selecting from a range of values provided or a 
command that can be executed to display or print a status or setting value.

• Emboldened values are the defaults. 

• Certain menus and items associated with options (for example, the optional trays) 
appear only if the associated hardware is installed or under certain conditions, as 
specifi ed.
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Functions Menu Tree:  Admin Setup, Calibration, Print Statistics   

Function Submenu 1 Submenu 2
Admin Setup 
(password  protected)  

Password (see “Password” 
later in this Appendix)  

–

Network Setup (see 
“Network Setup” later in 
this Appendix)  

TCP/IP
IPVersion
NetBEUI
NetWare
EtherTalk
Frame Type
IP Address Set
IP Address
Subnet Mask
Gateway Address
Web
Telnet
FTP
SNMP
Network Scale
Hub Link Setting
Factory Defaults
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Function Submenu 1 Submenu 2
Admin Setup (cont.) Print Setup (see “Print 

Setup” later in this 
Appendix)  

Personality
Copies
Duplex
Job Offset
Output Bin
Media Check
Resolution
Toner Save Mode
Mono-print speed
Default Orientation
Form Length
Edit Size
Trapping
X Dimension
Y Dimension

PS Setup (see “PS Setup” 
later in this Appendix)  

Network Protocol
Parallel Protocol
USB Protocol

PCL Setup (see “PCL 
Setup” later in this 
Appendix)  

Font Source
Font Number
Font Pitch
Symbol Set
A4 Print Width
White Page Skip
CR Function
LF Function
Print Margin
True Black
Pen-width Adjust
Tray ID#
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Function Submenu 1 Submenu 2
Admin Setup (cont.) IBM PPR Setup (see 

“IBM PPR Setup” later in 
this Appendix)  

Character Pitch
Font Condense
Character Set
Symbol Set
Letter O Style
Zero Character
Line Pitch
White Page Skip
CR Function
LF Function
Line Length
Form Length
TOF Position
Left Margin
Fit to Letter
Text Height
Continuous Paper Mode

Epson FX Setup (see 
“Epson FX Setup” later in 
this Appendix)  

Character Pitch
Character Set
Symbol Set
Letter O Style
Zero Character
Line Pitch
White Page Skip
CR Function
Line Length
Form Length
TOF Position
Left Margin
Fit to Letter
Text Height
Continuous Paper Mode

Color Setup (see “Color 
Setup” later in this 
Appendix)  

Ink Simulation
UCR
CMY 100% Density
CMYK Conversion

Memory Setup (see 
“Memory Setup” later in 
this Appendix)  

Receive Buffer Size
Resource Save

Flash Memory Setup (see 
“Flash Memory Setup” 
later in this Appendix)  

Initialize
Resize PS Area
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Function Submenu 1 Submenu 2
Admin Setup (cont.) HDD Setup (see “HHD 

Setup” later in this 
Appendix)  

Initialize
Resize Partition
Format Partition

System Setup (see 
“System Setup” later in 
this Appendix)  

Near Life LED

Change Password   New Password
Verify Password

Settings (see“Settings” 
later in this Appendix)     

Reset Settings
Save Settings

Calibration (see 
“Calibration 
Menu” later in this 
Appendix)  

Auto Density Mode ON
OFF

Auto BG Adjustg Mode OFF:[-1...+2]
Adjust Density   Execute
Adjust Registration  Execute
Heavy Media Adjust OFF [-5...+5]
Print Tuning Pattern  Execute
Cyan Tuning  Highlight

Mid-Tone
Dark

Magenta Tuning  Highlight
Mid-Tone
Dark

Yellow Tuning   Highlight
Mid-Tone
Dark

Black Tuning  Highlight
Mid-Tone
Dark

Cyan Darkness [-3...+3]
Magenta Darkness [-3...+3]
Yellow Darkness [-3...+3]
Black Darkness [-3...+3]
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Boot Menu Tree  

Parallel Setup

Item Value Description

Parallel Enable
Disable

Enables/Disables the Centronics interface.

Bi-Direction Enable
Disable

Enables/Disables the bi-directional Centronics 
interface.

ECP Enable
Disable

Enables/Disables the ECP mode

Ack Width Narrow
Medium
Wide

Sets the ACK width for compatible reception.
Narrow = 0.5μs
Medium = 1.0μs
Wide = 3.0μs

Ack/Busy Timing Ack in Busy
Ack while busy

Sets the order to output the BUSY signal and ACK 
signal for compatible reception.

I-Prime 3 microseconds
50 microseconds
Disable

Sets the time to enable/disable the I-PRIME 
signal.

Offl ine Receive Enable
Disable

Enables/disables a function that maintains the 
receive-possible stat without changing an interface 
signal even though an alarm occurs. When this 
is set to Enable, the interface keeps the receive-
possible status even when you press the Off-line 
operation panel switch. The interface sends the 
BUSY signal only when the reception buffer is full 
or a service call occurs.
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USB Setup

Item Value Description

USB Enable
Disable

Enables/Disables the USB interface.

Speed 480 Mbps
12Mbps

Sets the maximum SUB interface transfer speed.

Soft Reset Enable
Disable

Enables/Disables the Soft Reset command.

Offl ine Receive Enable
Disable

Enables/disables a function that maintains the 
receive-possible stat without changing an interface 
signal even though an alarm occurs. When this 
is set to Enable, the interface keeps the receive-
possible status even when you press the Off-line 
operation panel switch. The interface sends the 
BUSY signal only when the reception buffer is full 
or a service call occurs.

Serial Number Enable
Disable

Enables/disables the USB serial number, used to 
identify a USB device to which a PC is connected.

Security Setup

Item Value Description
Job Limitation Off

Encrypted Job
Controls the job limitation mode. If Encrypted Job 
is selected the printer will only allow this type of 
job to be printed and will discard all others.

Storage Setup

Item Value Description

Check File
System

Execute Resolves any mismatch between actual memory 
and displayed memory available in a fi le 
system and preforms administration data (FAT 
information) recover. Performs these by fi le 
system. This function takes several tens of seconds 
to complete.
HDD: Performs recover only for a HDD.
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Item Value Description

Check All Sectors Execute Performs recover of a defective HDD sector 
information and a fi le system mismatch as 
mentioned above. It takes 30 to 40 minutes to 
complete this function for a HDD of 10GB.

Enable HDD No
Yes

Even if a machine is inoperable at installation 
because a HDD has been damaged, you can 
make the machine operable by setting to NO to 
signify that no HDD is attached, regardless of the 
existence of a HDD. While NO is set, access to a 
HDD results in FAIL because the HDD is regarded 
as not attached even if the HDD is operating 
normally.

Erase HDD Execute Appears only when a HDD has been installed in 
the printer.
This function erases all data from the disk. The 
data cannot be restored.
Exiting the menu after a setting is made restarts 
the printer, starting erasing the disk. The percent 
progress of the erasing is displayed on the 
operation panel.
Pressing Enter displays the following confi rmation 
message:
Are You Sure?
- Yes
- No
Selecting No returns the display to the previous 
menu screen. By selecting Yes, the menu is 
immediately exited, the printer reboots, and the 
erasing operation starts. Pressing and holding 
the Cancel button during erasing displays the 
following confi rmation message for cancellation 
of the erasing:
Did You Cancel?
-Yes
-No
Selecting No continues the erasing.
Selecting Yes cancels the erasing, formats the disk 
and restarts the printer.

Enable
Initialization

No
Yes

Prevents a setup change accompanying 
initialization of Block Device (HDD, FLASH).
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Power Setup

Item Value Description

Peak Power
Control

Normal
Low

The fuser of the printer as two lamps. When the 
lamps run on, the printer’s power draw increases 
dramatically.
Normal: Both lamps light at the same time. When 
this happens, the printer’s power draw increases 
dramatically.
Low: The lamps do NOT light at the same time, 
The printer’s electrical draw increases, but not as 
dramatically.

Power Save Enable
Disable

Enables/disables the power save mode.

Moisture Control On
Off

Sets Off/On of Moisture Control mode. When 
On, the printer may take some time to complete 
printing the fi rst-off sheet.

Language Initialize Setup

Item Value Description

Execute Yes
No

Ilumina Menu Making Changes in the Menu 

Making Changes in the Function Menu

1. Ensure that the display panel indicates that the Ilumina is ready to print.
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2. Press the Enter button to switch to the Menu mode.

3. Press the  button to scroll down to the Function you wish to change, then 
press the Enter button.

4. Continue to use the ,  and Enter buttons in a similar manner to drill down 
to the item you wish to change.

5. Use the  and  buttons to scroll to the setting you wish to engage, then press 
Enter. An Asterisk (*) appears next to the new setting.

6. Press the Online button to exit menu mode and return to the Ready to print 
status.

Example: Enabling FTP 

1. Ensure that the display panel indicates that the Ilumina is ready to print.

2. Press the Enter button to switch to the Menu mode.

3. With [Confi guration] highlighted, press the Enter button to select this menu.

4. Press the  and/or  buttons repeatedly until [Admin Setup] is highlighted.

5. Press the Enter button to select this item.

6. Press the  and/or  buttons to enter the fi rst digit of the password, then press 
the Enter button.

7. Repeat the previous step for each digit of the password.

8. Press the Enter button to go into the [Admin Setup] menu.

9. With [Network Setup] highlighted, press the Enter button.

10. Press the  and/or  buttons repeatedly until [FTP] is highlighted.

11. Use the  or  buttons to highlight [Enable].

12. Press the Enter button to engage the setting. An Asterisk (*) appears next to the 
new setting.

13. Press the Online button to exit menu mode and return to the Ready to print 
status.
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Making Changes in the Boot Menu

1. Turn the Ilumina OFF.

2. Press and hold the Enter button while turning the Ilumina back on: be sure to 
keep pressing the Enter button until [Initializing] appears on the display.

3. Use the  and  buttons to scroll to an entry and the Enter button to select the 
entry, until you reach the item you wish to change.

4. Use the  and  buttons to scroll down to the setting you wish to engage, 
then press the Enter button. An Asterisk (*) appears next to the new setting.

5. Press the Online button to exit menu mode and return to the Ready to print 
status.

Ilumina Menu Functions List

Admin Setup  

Password 

Item Value Description
Enter password  nnnn Enter a password to enter the Administrator menu.

The default password is aaaaaa (six “a’s”).

Network Setup  

Item Value Description
TCP/IP  Enable

Disable
Enables/Disables the TCP/IP protocol.

IP Version IP v4
IP v4+v6
IP v6

Set up the IP Version.
Display condition: TCP/IP protocol must be 
enables.

NetBEUI  Enable
Disable

Enables/Disables the NETBEUI protocol.

NetWare   Enable
Disable

Enables/Disables the NetWare protocol.
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Item Value Description
EtherTalk   Enable

Disable
Enables/Disables the EtherTalk protocol.

Frame Type  Auto
802.2
802.3
Ethernet II
SNAP

Sets the frame type (NetWare).

IP Address   Set Auto
Manual

Sets IP address setup method (TCP/IP).

IP Address  xxx.xxx.xxx.xxx Sets the IP address (TCP/IP).
Subnet Mask  255.255.255.0 Sets the Subnet Mask (TCP/IP).
Gateway   Address xxx.xxx.xxx.xxx Sets the Gateway (default router) address (TCP/

IP).
Web  Enable

Disable
Enables/Disables the Web/IPP (TCP/IP).

Telnet  Enable
Disable

Enables/Disables Telnet (TCP/IP).

FTP  Enable
Disable

Enables/Disables FTP (TCP/IP).

SNMP  Enable
Disable

Enables/Disables SNMP of FTP (TCP/IP or 
NetWare).

Network Scale  Normal
Small

Normal: Can work effectively even when 
connected to a HUB that has a spanning tree 
feature. However, Ilumina start up time gets longer 
when computers are connected to two or three 
small LANs.

Small: Computers can cover from two or three 
small LANs to a large LAN, but it may not work 
effectively when it is connected to a HUB with a 
spanning tree feature.

Hub Link Setting  Auto Negotiate
1000Base-T Full
100Base-T Full
100Base-T Half
10Base-T Full
10Base-T Half

Sets the hub linking method.

Factory
Defaults?

Execute Specifi es whether to initialize the network menu.
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Print Setup  

Item Value Description
Personality   Auto

PostScript
PCL
IBM PPR
EPSON FX

Selects a printer language.

Copies  1 ~ 999 Sets number of copies. Disabled for local print, 
except for demo data.

Duplex  ON
OFF

Specifi es duplex printing.

Binding  LongEdge
ShortEdge

Specifi es how to bind duplex printing.

Job Offset  ON
OFF

Enables/Disables Job offset.

Output Bin  Facedown
Faceup

Specifi es where to eject prints.

Media Check  Enable
Disable

Enables/Disables whether the Ilumina checks that 
paper size required by the print data matches that 
of the tray. Only standard sizes can be checked.

Transparency 
Detect  

Auto
Disable

Enables/Disables the automatic detection of 
transparencies. (Use it while detecting sensor 
mistakes).

Resolution  600dpi
600x1200dpi
600dpi multi-level

Sets the resolution.

Toner Save Mode  ON
OFF

Sets toner saving mode.

Mono-Print Speed  Auto
Color speed
Normal speed

Sets the monochrome print speed.
Auto: prints at most appropriate speed for page.
Color speed: always prints at color speed.
Normal speed: always prints at monochrome 
speed.

Default 
Orientation  

Portrait
Landscape

Sets printing orientation (only for PCL, IBMPPR, 
EPSONFX). Invalid for PS.
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Item Value Description
Form Length  5 ~ 60 (L) ~ 64 (A) 

~ 128 lines
Sets the number of lines printable on one page 
(only for PCL).
Invalid for PS.
The emboldened default values given are for 
Letter (L) and A4
(A). In practice, the values change 
corresponding to the size of paper in the tray.

Edit Size Cassette size
Letter short edge
Letter long edge
Executive Legal 14
Legal 13.5 Legal 13
Tabloid Extra, 
Tabloid
A3 Nobi, A3 wide, 
A3
A4 short edge
A4 long edge
A5, 6, B4
B5 short edge
B5 long edge
Custom
Com-9 Envelope
Com-10 Envelope
Monarch Envelope
DL Envelope 
Postcard
Double postcard
C5, C4
Index card

Specifi es the size of an area to draw when there 
is no specifi cation of a size by predefi ned paper 
edit size command from a host PC (only valid for 
PCL). Invalid for PS.

Trapping Off
Narrow
Wide

Sets trapping.

X Dimension 3.0 ~ 8.5 ~ 12.9 
inch
(76 ~ 328 mm)

Sets default Custom paper width, perpendicular to 
the direction of motion of paper.

Y Dimension 3.5 ~ 11 ~ 47.2 inch
(90 ~ 1200 mm)

Sets default Custom paper length, in the same 
direction as the direction of motion of paper.
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PS Setup  

Item Value Description
Network Protocol  ASCII

RAW
Specifi es PS transmission protocol 
for network data. It does not appear 
for Non-PS type.

Parallel Protocol  ASCII
RAW

Specifi es PS transmission protocol 
for Centronics data. It does not 
appear for Non-PS type.

USB Protocol  ASCII
RAW

Specifi es PS transmission protocol 
for USB data. It does not appear for 
Non-PS type.

PCL Setup    

Item Value Description
Font Source Resident

Resident2
Downloaded

Specifi es the location of the PCL 
default font. RESIDENT2: displayed 
only when Heisei Font is installed.
DOWNLOADED: displayed when 
software font is downloaded to RAM 
as permanent designation. Fonts 
downloaded to Flash and HDD by PJL 
command are not displayed in this 
menu.

Font Number  10
C1
S1

Sets the PCL font number.

Font Pitch  0.44 ~ 99.99 CPI
Default 10.00 CPI

Sets the width of the PCL default fonts.

Font Height  4.00 ~ 999.75 point
Default 12.00 point

Sets the height of the PCL default font.
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Item Value Description
Symbol Set  PC-8, PC-8 Dan/Nor PC-8, TK, PC-775, PC-850, PC-852, C-855, PC-

857 TK, PC-858, PC-864L/A, PC-866, PC-869, PC-1004, Pi Font, Plska 
Mazvia, PS Math, PS Text, Roman-8, Roman-9, Roman Ext, Serbo Croat1, 
Serbo Croat2, Spanish Ukrainian, VN Int’l, VN Math, VN US, Win 3.0, 
Win 3.1 Blt, Win 3.1 Cyr, Win 3.1 Grk, Win 3.1 Heb, Win 3.1 L1, Win 
3.1 L2, Win 3.1 L5, Wingdings Dingbats MS Symbol, OCR-A, OCR-B, 
HP ZIP, USPSFIM, USPSSTP, USPSZIP, Bulgarian, CWI Hung DeskTop 
German, Greek-437, Greek-437 Cy Greek-737, Greek-928, Hebrew NC 
Hebrew OC, IBM-437, IBM-850, IBM-860, IBM- 863, IBM-865, ISO 
Dutch, ISO L1, ISO L2, ISO L5, ISO L6, ISO L9, ISO Swedish1, ISO 
Swedish2, ISO Swedish3, ISO- 2 IRV, ISO-4 UK, ISO-6 ASC, ISO-10 S/F 
ISO-11 Swe, ISO-14 JASC, ISO-15 Ita, ISO-16 Por, ISO-17 Spa, ISO-21 
Ger, ISO-25 Fre, ISO-57 Chi, ISO-60 Nor, ISO-61 Nor, ISO-69 Fre, ISO-84 
Por, ISO-85 Spa Kamenicky Legal, Math-8, MC Text, MS Publish, PC Ext 
D/N, PC Ext US, PC Set1, PC Set2 D/N , PC Set2 US, WIN3.1J

A4 Print Width  78 column
80 column

Sets line width subject to Auto LF with A4 
paper in PCL.

White Page Skip  OFF
ON

Sets to eject a page with non-print data (blank 
page) on receipt of the FF command (0CH) in 
PCL. Set to OFF for ejection.

CR Function  CR
CR+LF

Sets the operation on receipt of a CR code in 
PCL. (NL means new line).

LF Function  LF
LF+CR

Sets the operation on receipt of a LF code in 
PCL. (NL means new line).

Print Margin  Normal
1/5 inch
1/6 inch

Sets the margin for paper printable area.

True Black  OFF
ON

Sets use in PCL of Composite Black (mixed 
color of CMKY) or Pure Black (only K) for 
black (100%).
OFF: Sets Composite Black.
ON: Sets Pure Black. Invalid for PS.

Pen Width Adjust  ON
OFF

The thinnest line width in PCL, a 1-dot line, 
may look broken.
ON: when the thinnest line width is specifi ed, 
line width is emphasized to look wider.
OFF: the line appears as specifi ed.
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Item Value Description
Tray ID#  
  – Tray2
  – Tray3
  – Tray4
  – Tray5

1 ~ 5 ~ 59
1 ~ 20 ~ 59
1 ~ 21 ~ 59
1 ~ 22 ~ 59

Sets the number to specify Tray2, Tray3, 
Tray4, and Tray5 for the paper feed destination 
command in PCL5e emulation.

  – MP Tray 1 ~ 4 ~ 59 Sets the number to specify MP Tray for the 
paper feed destination command in PCL5e 
emulation

IBM PPR Setup    

Item Value Description
Character pitch 10CPI, 12CMI, 17CPI, 

20CPI, Proportional
Sets the character pitch

Font condense 12 to 20 CPI
12 to 12CPI

Ses the 12CPI pitch for Condensed printing 
mode.

Character set SET-2, SET-1 Sets the character set to be used.
Symbol Set IBM-437, IBM-850, IBM-860, IBM-863, IBM-865, PC Set1, PC Ext US, 

PC Ext D/N, PC Set2 US, PC Set2 D/N, Roman-8, ISO L1, PC-8, PC-8 
Dan/Nor, PC-850, Legal, ISO-2 IRV, ISO-4 UK, ISO-6 ASC, ISO-10 S/F, 
ISO-11 Swe, ISO-14 JASC ISO-15 Ita. ISO-16 Por. ISO-17 Spa. ISO-21 
Ger. ISO-25 Fre. ISO-57 Chi. ISO-60 Nor, ISO-61 Nor, ISO-69 Fre, ISO-84 
Por, ISO-85 Spa, German, Spanish, ISO Dutch, Roman Ext, ISO Swedish1, 
ISO Swedish2, ISO Swedish3, VN Math, VN Int’l, VN US, PS Math, PS 
Text, Math-8, Pi Font, MS Publish, Win 3.0, DeskTop, Win 3.1 L1, MC 
Text, PC-852, Win 3.1 L5, Win 3.1 L2, CWI Hung, PC-857 TK, ISO L2, 
ISO L5, PC-8 TK, Kamenicky, Hebrew NC, Hebrew OC, Plska Mazvia, 
ISO L6, Win 3.1 Heb, Win 3.1 Cyr, PC-866, Win 3.1 Grk, PC-869, PC-855, 
Greek-437, Greek-437 Cy, Greek-737, Greek-928, Serbo Croat2, Ukrainian, 
Bulgarian, PC-1004, Win 3.1 Blt, PC-775, Serbo Croat1, PC-858, Roman-9,  
ISO L9

Letter O style Enable
Disable

Sets the letter O style.

Zero character Normal
Slashed

Set to O style.

Line pitch 6LPI
8LPI

Sets the line pitch

White page skip OFF
ON

Sets whether a blank sheet is ejected.
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Item Value Description
CR function CR

CR+LF
Sets the action when the CR code is received.

LF function LF
LF+CR

Set the action when the LF code is received.

Line length 80 column
136 column

Sets the number of characters per line.

Form length 11 inch
11.7 inch
12 inch

Sets the paper length.

TOF position 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the top edge of the 
paper.

Left margin 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the left edge of the 
paper.

Fit to letter Enable
Disable

Set the print mode that fi ts print data equivalent 
to 11 inch (66 lines) into Letter size printable 
area.

Text height Same
Diff

Set character height.
Same: same height, regardless of CPI.
Diff: character heights vary according to CPI.

Cont paper mode ON
OFF

Sets the edit direction of paper supported by A3 
printer to landscape.

Epson FX Setup    

Item Value Description
Character pitch 10CPI, 12CMI, 17CPI, 

20CPI, Proportional
Sets the character pitch

Character set SET-2, SET-1 Sets the character set to be used.
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Item Value Description
Symbol Set IBM-437, IBM-850, IBM-860, IBM-863, IBM-865, PC Set1, PC Ext US, 

PC Ext D/N, PC Set2 US, PC Set2 D/N, Roman-8, ISO L1, PC-8, PC-8 
Dan/Nor, PC-850, Legal, ISO-2 IRV, ISO-4 UK, ISO-6 ASC, ISO-10 S/F, 
ISO-11 Swe, ISO-14 JASC, ISO-15 Ita, ISO-16 Por, ISO-17 Spa, ISO-
21 Ger, ISO-25 Fre, ISO-57 Chi, ISO-60 Nor, ISO-61 Nor, ISO-69 Fre, 
ISO-84 Por, ISO-85 Spa, German, Spanish, ISO Dutch, Roman Ext, ISO 
Swedish1, ISO Swedish2, ISO Swedish3, VN Math, VN Int’l, VN US, PS 
Math, PS Text, Math-8, Pi Font, MS Publish, Win 3.0, DeskTop, Win 3.1 
L1, MC Text, PC-852, Win 3.1 L5, Win 3.1 L2, CWI Hung, PC-857 TK, 
ISO L2, ISO L5, PC-8 TK, Kamenicky, Hebrew NC, Hebrew OC, Plska 
Mazvia, ISO L6, Win 3.1 Heb, Win 3.1 Cyr, PC-866, Win 3.1 Grk, PC-869, 
PC-855, Greek-437, Greek-437 Cy, Greek-737, Greek-928, Serbo Croat2, 
Ukrainian, Bulgarian, PC-1004, Win 3.1 Blt, PC-775, Serbo Croat1, PC- 
858, Roman-9, ISO L9

Letter O style Enable
Disable

Sets the letter O style.

Zero character Normal
Slashed

Set to O style.

Line pitch 6LPI
8LPI

Sets the line pitch

White page skip OFF
ON

Sets whether a blank sheet is ejected.

CR function CR
CR+LF

Sets the action when the CR code is received.

Line length 80 column
136 column

Sets the number of characters per line.

Form length 11 inch
11.7 inch
12 inch

Sets the paper length.

TOF position 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the top edge of the 
paper.

Left margin 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the left edge of the 
paper.

Fit to letter Enable
Disable

Set the print mode that fi ts print data equivalent 
to 11 inch (66 lines) into Letter size printable 
area.

Text height Same
Diff

Set character height.
Same: same height, regardless of CPI.
Diff: character heights vary according to CPI.
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Item Value Description
Cont paper mode ON

OFF
Sets the edit direction of paper supported by A3 
printer to landscape.

Color Setup  

Item Value Description
Ink Simulation  OFF

SWOP
Euroscale
Japan

Simulates a standard printing color by the 
Ilumina. The function is valid only for jobs 
using PS languages.

UCR  Low
Medium
High

Sets toner layer thickness. (Medium or Low 
may help reduce any paper curl that occurs.)

CMY  
100% Density

Enable
Disable

Enable/disable 100% output against 
CMY100% TRC compensation.
Selecting ENABLE will enable 100% output 
in individual color. The actual print, including 
the TRC compensation function is limited 
to an appropriate area. This function is for 
a special purpose such as specifi cation in 
CMYK color diminution of PS.

CMYK Conversion  ON
OFF

Set to OFF to simplify the conversion process 
of CMYK data and reduce the processing 
time. This setting is ignored when the Ink 
Simulation function is used.

Memory Setup  

Item Value Description
Receive Buffer Size   Auto

0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the size of the receive buffer.
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Item Value Description
Resource Save Auto

Off
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the size of the resource saving area.

Flash Memory Setup  

Item Value Description
Initialize   Execute Initializes resident fl ash memory.
Resize PS Area nn% [n.n MB] Sets the size of the PS area in resident fl ash 

memory.

HDD Setup  

Item Submenu Item Value Description
Initialize     Execute Initializes the HDD to the factory 

default state.
Resize Partition PCL

Common
PS

nn%
mm%
ll%

Sets partition size.

Format Partition PCL
Common
PS

– Sets the format of a specifi ed 
partition.

System Setup  

Item Value Description
Near Life LED Enable

Disable
Enables the Attention LED to be turned on when a warning for 
NEAR LIFE of a toner, a drum, a fuser, or a belt occurs.    
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Change Password   

Item Value Description
New Password    nnnn Sets a new password to enter Admin Setup.
Verify Password nnnn Lets a user verify the new password to be used to enter Admin 

Setup.

Settings      

Item Value Description
Reset Settings Execute Resets EEPROM of the CU. Returns a user’s menu setup to 

the factory default state.
Save Settings Execute Saves the current menu settings.
Restore settings Execute Changes the menu settings saved.

Calibration Menu

Item Value or 
Submenu 
Item

Value Description

Auto Density 
Mode

ON
OFF

– Sets whether density adjustment and TRC 
compensation is automatically performed.
ON: density adjustment is automatically run 
under the Ilumina specifi ed conditions and 
refl ected in TRC compensation.
OFF: the Ilumina does not carry out density 
adjustment automatically.

Auto BG adjust 
mode

Off
[-1...+2]

- Prevents dirty print backgrounds caused 
by unstable toner charging conditions. The 
print density sensor detects the toner electric 
potentials and automatically adjusts supply 
voltage (SB) and charging voltage (CH). The 
menu does not appear when auto density 
mode is set to OFF.
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Item Value or 
Submenu 
Item

Value Description

Adjust Density Execute – When Execute is selected, the Ilumina 
carries out density compensation 
immediately and refl ects it in TRC 
compensation. Density adjustment must be 
carried out when the Ilumina is idling.

Adjust 
Registration

Execute – When Execute is selected, the Ilumina 
carries out registration adjustment 
automatically. Registration adjustment 
must be carried out when the Ilumina is 
idling.

Heavy media 
adjust

Off
[-5...+5]

Adjusts the fusing speeds for printing 
on heavy media.
A value other than OFF adjusts 
the speed based on the automatic-
adjustment value that has been set.

Print Tuning 
Pattern

Execute – Allows you to print a pattern to help you 
adjust TRC manually. (Normally, TRC is 
automatically adjusted to the recommended 
levels through density adjustment and TRC 
compensation.)

Cyan Tuning
Magenta Tuning
Yellow Tuning
Black Tuning

Highlight [-3...+3] Adjusts highlight (light area) of Cyan, 
Magenta, Yellow, or Black TRC. Plus 
indicates adjustment towards darker and 
minus towards lighter.

Mid-Tone [-3...+3] Adjusts mid tone of Cyan, Magenta, Yellow, 
or Black TRC. Plus indicates adjustment 
towards darker and minus towards 
lighter.

Dark [-3...+3] Adjusts dark (dense area) of Cyan, Magenta, 
Yellow, or Black TRC. Plus indicates 
adjustment towards darker and minus 
towards lighter.

Cyan Darkness
Magenta Darkness
Yellow Darkness
Black Darkness

[-3...+3] - Adjusts the engine density.
The darkness settings are offset (additional) 
values on the results of the adjustments 
made with the Adjust Density or Tuning 
functions.
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Print Statistics Menu

Item Value Description
Password entry nnnn Enter password. The default password is 0000 (four 

zeroes).
When there is no support for the print statistics function, 
Print Statistics is not displayed.

Statistics log Enable
Disable

Enables/Disables the print statistics function.

Log Size 1 ~ 30 ~100 Sets the log size.
Conditions for display:
- HDD is installed.
- Enable is selected in Functions > Print Statistics > 
Statistics Log.

Reset counter Execute Clears the counter back to zero.
Conditions for display:
Enable is selected in Functions > Print Statistics > 
Statistics Log.

Change password - Sets a new password to enter the Print Statistics menu.
New password nnnn Input the new password again to confi rm.
Verify password nnnn

Ilumina Menu Boot Menu
To access the Boot Menu:

1. Turn the Ilumina off.

2. Press and hold the Enter key while turning the Ilumina back on: be sure to 
continue holding the Enter key until “Initializing” appears on the display.

Parallel Setup

Item Value Description
Parallel Enable

Disable
Enables/Disables the Centronics interface.

Bi-Direction Enable
Disable

Enables/Disables the bi-directional Centronics 
interface.
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Item Value Description
ECP Enable

Disable
Enables/Disables the ECP mode.

Ack Width Narrow
Medium
Wide

Sets the ACK width for compatible reception. 
Narrow = 0.5μs. 
Medium = 1.0μs. Wide = 3.0μs

Ack/Busy Timing Ack in Busy
Ack while Busy

Sets order to output the BUSY and ACK signals for 
compatible reception.

I-Prime 3 microseconds
50 microseconds
Disable

Sets the time to enable/disable the I-PRIME signal.

Offl ine Receive Enable
Disable

When this is set to Enable, the interface keeps the 
receive-possible state even when you press the Off-
line operating panel switch. The interface sends the 
BUSY signal only when the reception buffer is full 
or a service call occurs. PS only.

USB Setup

Item Value Description
USB Enable

Disable
Enables/Disables the USB interface.

Speed 480Mbps
12Mbps

Sets the maximum USB interface transfer speed.

Soft Reset Enable
Disable

Enables/Disables the Soft Reset command.

Offl ine Receive Enable
Disable

When this is set to Enable, the interface keeps the receive-
possible state even when you press the Offl ine operating 
panel switch. The interface sends the BUSY signal only 
when the reception buffer is full or a service call occurs. PS 
only.

Serial Number Enable
Disable

Enables/Disables the USB serial number, used to identify a 
USB device to which a PC is connected.
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Security Setup

Item Value Description
Job Limitation Off

Encryptede Job
Controls the job limitation mode. If Encrypted Job 
is selected the printe rwill only allow this jype of 
job to be printed and will discard all others.

Storage Setup

Item Value Description
Check File System Execute Resolves any mismatch between actual memory and 

displayed memory available in a fi le system and performs 
administration data (FAT information) recovery. Performs 
these by fi le system. This function takes several tens of 
seconds to complete. HDD: Performs recovery only for 
HDD.

Check All Sectors Execute Performs recovery of a defective HDD sector information 
and a fi le system mismatch as mentioned above. It takes 
30 to 40 minutes to complete this function for an HDD of 
10GB.

Enable HDD No
Yes

Even if a machine is inoperable at installation because 
an HDD has been damaged, you can make the machine 
operable by setting to NO to signify that no HDD is 
attached, regardless of the existence of an HDD. While NO 
is set, access to an HDD results in FAIL because the HDD 
is regarded as not attached even if the HDD is operating 
normally.
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Item Value Description
Erase HDD Execute Appears only when a HDD has been installed in the 

printer.
This function erases all data from the disk. The data cannot 
be restored.
Exiting the menu after a setting is made restarts the printer, 
starting erasing the disk. The percent progress of the 
erasing is displayed on the operation panel.
Pressing Enter displays the folling confi rmation message:
Are You Sure?
- Yes
- No
Selecting No returns the display to the previous menu 
screen. By selecting Yes, the menu is immediately exited, 
the printer reboots, and the erasing operatio starts. Pressing 
and holding the Cancel button during erasing displays the 
following confi rmation message for cancellation of the 
erasing:
Did You Cancel?
-Yes
-No
Selecting No continues the erasing.
Selecting Yes cancels the erasing, formats the disk and 
restarts the printer.

Enable Initialization No
Yes

Prevents a setup change accompanying initialization of 
Block Device (HDD, FLASH).

Power Setup

Item Value Description

Peak Power
Control

Normal
Low

The fuser of the printer as two lamps. When the 
lamps run on, the printer’s power draw increases 
dramatically.
Normal: Both lamps light at the same time. When 
this happens, the printer’s power draw increases 
dramatically.
Low: The lamps do NOT light at the same time, 
The printer’s electrical draw increases, but not as 
dramatically.

Power Save Enable
Disable

Enables/disables the power save mode.
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Item Value Description

Moisture Control On
Off

Sets Off/On of Moisture Control mode. When 
On, the printer may take some time to complete 
printing the fi rst-off sheet.

◊◊◊


